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Introduction to the manual 

What this chapter contains 

This chapter gives basic information on the manual.  

 
Compatibility 

This manual applies to the ABB drives that are equipped with the embedded PLC 
functionality. For example, ABB ACS880 industrial drives can be ordered with the 
embedded PLC programmability.  

This manual is compatible with the ACS880 primary control program version 1.3 or later.  

This manual is compatible with the ABB PS501 Control Builder Plus (CBP) version 2.3 or 
later. Control Builder Plus is part of the ABB Automation builder 1.0 engineering software 
suite. 

 
Safety instructions 

Follow all safety instructions delivered with the drive. 
• Read the complete safety instructions before you load and execute the IEC 

program on the drive or modify the drive parameters. The complete safety instructions 
are delivered with the drive as either part of the hardware manual, or, in the case of 
ACS880 multidrives, as a separate document. 

• Read the firmware function-specific warnings and notes before changing 
parameter values. These warnings and notes are included in the parameter 
descriptions presented in chapter Parameters of the firmware manual. 

1 
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Note: Performing on-line changes or program download in a running drive may have 
unforeseen consequences and should be avoided. 

 
Target audience 

This manual is intended for people who perform drive IEC programming or wish to 
understand the programming environment capabilities. The reader of the manual is 
expected to have basic knowledge of the drive technology and programmable devices 
(the PLC, drive and PC) and programming methods. 

 
Purpose of the manual 

This manual gives basic instructions on the drive-based IEC programming using the ABB 
Control Builder Plus programming tool. The on-line help of Control Builder Plus contains 
more detailed information of the IEC languages, programming methods, editors and tool 
commands. 

Note: The drive’s embedded PLC has some functional deviations from the standard 
CoDeSys V3 programming. The deviations are listed in Unsupported features. 

 
Contents of the manual 

The manual consists of the following chapters: 
• Drive IEC programming 
• Installation 
• Creating application program 
• Features 
• DriveInterface 
• Application parameter and event creation 
• Libraries 
• Practical examples and tips 
• Appendix – Incompatible features between V3 and V2.3 
• Appendix - Unsupported features of CoDeSys V3 
• Appendix – ABB drives system library 
• Appendix – ABB drives standard library 

 

Related documents 

A list of related manuals is printed on the inside of the front cover.  

 
Terms and abbreviations 

Term/Abbreviation Description 

ACS-AP-x ACS-AP-I or ACS-AP-S control panel used with ACS880 drives. The control 
panel has an USB connector enabling a PC tool connection for common 
architecture drives. 

BCU Type of control unit used in ACS880 drives 
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CBP ABB Control Builder Plus programming tool 

CFC Continuous function chart programming language 

DI Digital input 

Drive composer pro Drive composer is a 32-bit Windows application for commissioning and 
maintaining ABB common architecture drives. 

The full version is called Drive composer pro. 

DUT Data type unit 

FB Function block, type of POU 

FBD Function block diagram programming language 

FUN Function, type of POU 

IEC programming Standardized programming language for industrial automation. Established by 
the International Electrotechnical Commission (IEC) 

IL Instruction list programming language 

LD Ladder diagram programming language 

OPC server OPC DA server interface for Drive composer pro that allows other programs, 
such as Control Builder Plus, to communicate with the drive. 

PIN IEC variable of the block, which can be connected to other blocks. 

PLC Programmable logic controller 

POU Program organization unit. POU unit is a unit, object or area where you can 
write the program code. Also called as Block. 

PRG Program, type of POU 

RTS Run-time system 

SFC Sequential function chart programming language 

ST Structured text programming language 

ZCU Type of control unit used in ACS880 drives that consists of a ZCON board built 
into a plastic housing. 

The control unit may be fitted onto the drive/inverter module, or installed 
separately. 

 

For more detailed descriptions, see also the CPB on-line help. 
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Drive IEC programming 

What this chapter contains 

This chapter describes the drive programming environment and a typical work cycle of 
the drive IEC programming. 

 
Drive’s embedded PLC 

ABB ACS880 industrial drives can be ordered with the embedded PLC functionality. It 
allows you to add your own program code to the drive using the ABB Control Builder Plus 
programming tool (version 2.3). The programming environment is based on the IEC 
61131-3 programming standard. ABB Control Builder Plus (CBP) is used also for 
configuring and programming the ABB AC500 PLC family devices.  

Note: For using ABB Control Builder Plus on-line with the drive, the IEC programming 
license must be enabled in the target drive. 

With the embedded PLC, you can create application-specific features on top of the drive’s 
firmware functionality and utilize the drive’s standard and extension I/O and 
communication interfaces and firmware signals for that purpose. Your program is 
executed in parallel with the drive control tasks and using the same hardware resources.  

In addition, you can create your own parameters and events (faults and warnings) that 
are visible on the ACS-AP-x control panel and in the Drive composer pro/entry 
commissioning tools. 

The following simplified system diagram shows the application programming environment 
in the same control unit as the drive firmware. 

 
 

2 
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Figure img1 

The following lists give the main components for application programming. 

Drive control unit: 
• Run-time system (RTS) to execute the application program 
• DriveInterface to make input/output mapping between the IEC program and drive 

firmware parameters 
• System function library to access the drive system services (parameters/ events/ 

drive-to- drive communication, extension I/O) 
• User-made parameters 
• User-made events (fault, warnings) 
• Drive System info includes version information of the application program. 

Drive memory unit: 
• Permanent version of the application program (Boot application) 
• Retain values of the IEC variables  
• Source code of the application (Note that the size of the memory is limited.)  
• Symbol and address information of the IEC variables for monitoring purposes. 

PC tool programs: 
• ABB Control Builder Plus 2.3 for IEC program development and on-line operations 
• ABB Drive composer pro for drive parameter, signal, event log monitoring  and 

settings 
• IEC function libraries (for example, ABB standard library). 
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Programming languages and modules 

The programming environment supports programming languages as specified in the 
IEC 61131-3 standard with some useful extensions. The supported programming 
languages are: 
• Ladder diagram (LD) 
• Function block diagram (FBD) 
• Structured text (ST) 
• Instruction list (IL) 
• Sequential function chart (SFC) 
• Continuous function chart (CFC), normal and page-oriented CFC editor. 

A program can be composed of multiple modules like functions, function blocks and 
programs. Each module can be implemented independently with the above-mentioned 
languages. Each language has its own dedicated editors. For more information of the 
programming languages, see the on-line help of CBP and chapter Features. 

 
Libraries 

Program modules can be implemented in projects or imported into libraries. A library 
manager is used to install and access the libraries.  

There can be two main types of the libraries: 
• Local libraries (IEC language source code, for example, ABB drives standard library)  
• External libraries (external implementation and source code, for example, ABB drives 

system library) 

Local libraries can include source code or be compiled. If the library is compiled, the 
source code is not included in the library.  

AC500 PLC libraries can be used with the drive target by opening the library project in 
Windows as Files of type: CoDeSys project files (before V3.0).  

For more information on compatibility, see chapter Libraries. 

 
Program execution  

The program is executed on the same central processing unit (CPU) as the other drive 
control tasks. In real-time applications, programs are typically executed periodically as 
cyclic tasks. The programmer can define the cyclic task interval. For more information, 
see chapter Features. 
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Programming work cycle 

The following list gives a typical work cycle of the drive IEC programming (the task/the 
means for performing the module in tool): 

 
1. Creating a new project, defining the target and first program module  / Devices tree 

(New Project and Add Object) 
2. Defining the interface to drive firmware parameters (I/O access, drive control) / 

DriveInterface 
3. Defining user parameters and events / ApplicationParametersandEvents module in 

the Devices tree 
4. Developing the program structure and coding program units / Editors 
5. Defining the program execution  / Task configuration editor 
6. Compiling and loading the code / Build menu 
7. Creating boot applications (needed always if new parameters, mappings, events or 

task configuration is added) / Online menu 
8. Debugging the program code (stepping, forcing variables and breakpoints) / Online 

menu 
9. Monitoring program variables in CBP and Drive composer pro / Editors and the Watch 

windows on the View menu 
10. Repeating the cycle from step 2 to 8 for testing the program. 

 

Special tasks: 
1. Saving or restoring the source code to the drive’s permanent memory / Online 
2. Saving the drive IEC symbol data to drive’s permanent memory / Devices tree (Add 

Symbol configuration object to the tree.) 
3. Naming and versioning the application / Application properties  
4. Removing the application from the target / Reset origin window on the Online menu 
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Installation 

What this chapter contains 

This chapter explains how to install ABB Control Builder Plus (CBP) and establish 
communication to the drive. 

 
Installing ABB Control Builder Plus 

Note: You must have the Administrator user rights to install Control Builder Plus.  

Control Builder Plus is part of the ABB Automation builder 1.0 engineering software suite. 

ABB Control Builder Plus supports Windows XP and Windows 7 (32-bit and 64-bit 
versions) operating systems.   
1. Install Drive composer pro to enable communication with the target drive. For the 

instructions, see Drive composer user’s manual (3AUA0000094606 [English]). 
2. In the Drive composer pro System info->Products/More, check that the ACS880 

drive has an active IEC programming license and the drive firmware version is 
correct. ADD picture 

3. Install ABB Control Builder Plus version 2.3 according to the instruction guide 
included in the installation media of Automation Builder. All drive IEC programming 
related components are automatically installed as well.  

3 
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4. In Automation Builder, select Install Software Packages for -> Programmable 
Drive. 

 
1. Run the registry settings Driveda_rename_win7.reg or Driveda_rename_winxp.reg by 

double-clicking the file to allow parallel use of the Drive composer pro and CBP. The 
files are located in folder Program 
Files\ABB\Controlbuilderplus\GatewayPLC\ProxyRTS\ProxyRTS_OPC. 
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Establishing communication to the drive 

You can connect your PC to the drive via the USB port of the ACS-AP-x control panel 
using a standard USB data cable (USB Type A <-> USB Type Mini-B).  For information 
on making the control panel-to-PC USB connection, see ACS-AP-x control panel user’s 
manual (3AUA0000085685 [English]). Ensure that the ACS-AP-x USB driver has been 
installed. If not, install them as instructed in Drive composer user’s manual 
(3AUA0000094606 [English]). 

The CoDeSys communication gateway handles communication between Control Builder 
Plus (CBP) and the drive. The gateway is a software component that is started 
automatically at the power-up of the PC after the installation of the CBP. See the icon in 
your Windows notification area (system tray). 

 

Figure img2 

You can select the communication gateway in the CBP. In theory, the gateway can be 
located also in some other PC or PLC than the CBP host PC. In the ABB configuration, 
only the local gateway is scanned and that is why only local communication ports can be 
used for drive communication.  

For more instructions on communication, see chapter Creating application program. 
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Creating application program 

What this chapter contains 

This chapter describes the following basic steps of application programming: 
1. Creating a new project 
2. Establishing an on-line connection to the drive 
3. Naming the application 
4. Writing and building program code 
5. Preparing a project for download 
6. Downloading  the program to the drive 
7. Executing the program 
 
More detailed instructions of further development steps are given in chapters 
DriveInterface, Application parameter and event creation, Features and Libraries. For 
more detailed descriptions, see also the CPB on-line help. 
 

4 
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Creating a new project 

After starting the ABB Control Builder Plus programming environment, you can create a 
new project.  

1. In Start Page, select Create a new project… or on the File menu, select New 
project... 

 
Figure img3 

2. In the New project dialog box, type the project Name and Location, click AC880 
project, then click OK. 

Figure img4 

3. In the Standard Project dialog box, select the type of the control unit (Device): 
• ACS880_AINF_ZCU11_M_V3_5 for ZCU-xx control unit  

Or 
• ACS880_AINF_BCU12_M_V3_5 for BCU-xx control units 

Check the control unit type of the target drive either from the unit itself, from the 
drive’s hardware manual or from your local ABB representative. 

4. Select the programming language PLC_PRG in:, then click OK. You can later add 
program modules made also with other languages to the project. 
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Figure img5 

A simple project for an ACS880 target drive is created in the Devices tree. 

         Figure img6 

The Devices tree includes: 
• PLC Logic 
• DriveInterface for firmware signal and parameter mapping. 

You can add, for example, the following objects under Application: 
• Library Manager for installing function libraries 
• ApplicationParametersandEvents for creating user parameters and events 
• Program organization units (POUs) 
• Task Configuration module for defining in which task the POUs are executed 
• Text list 
• Symbol configuration 
• Visualization 
• Global variable list 
• Data type units (DUT) 

 
For changing the device type, see Changing an existing device. 
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Establishing an on-line connection to the drive 

After defining the device type, you can establish an on-line connection to the target drive. 
1. In the Devices tree, double-click ACS880_AINF_ZCU11_M_V3_5 and then click the 

Communication Settings tab. 

Gateway-1 is displayed by default. 

 

 
Figure img7 

2. Ensure that the communication settings are correct:  

(If Gateway-1 is not available, click the Add gateway… button and select the 
gateway with the following settings.)  

Node Name: Gateway-1 

Driver:  TCP/IP 

IP- Address: localhost Remote gateways are not scanned. 

Port:  1217  See the following firewall note. 

Note: Check your firewall settings that may block connections to devices. ABB 
CoDeSys needs port 1217 for establishing a connection to the gateway. 

Note: If multiple nodes are displayed, it can mean that your ProxyRTS is started twice 
or that the IP-Address setting is not localhost (should not be possible to change). 

3. Check that the USB cable is connected to the USB connector of the ACS-AP-x control 
panel and the drive is powered.  
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4. To search for the target device, double-click Gateway-1 or click Gateway-1 -> the 
Scan network button. Filter:/Target ID displays only the devices that are of the same 
type as the device selected in the Devices window. 

The device of the gateway is added under Gateway-1. 

 
Figure img8 

5. Under Gateway-1, select the device and click the Set active path button (or double-
click the device, or right-click the device to see the shortcut menu and then click Set 
active path). 

 
Figure img8b 

After the device is set as active path, the project is ready for on-line communication 
with the drive. 

To see which port and node is used by each device, see the information in the device 
name in brackets [GGGG.PPNN] where:  

 
GGGG   is the gateway number. 
PP   is the OPC channel number. 
NN   is the OPC node number. 
 

 



27 

 

 

Naming the application 

It is a good idea to give a name and a version number for the application program in the 
very beginning.  This information is then visible in the Drive composer tool and ACS-AP-x 
control panel and helps to identify the loaded application without the Control Builder Plus 
tool. 
1. In the Devices tree, right-click Application and select Properties. 
2. In the Common tab, enter the name of the application (30 characters). 

    Figure img13 

 
3. In Properties, select the Information tab, enter the author, company, version and 

description of the application. The CBP tool version and project identification code are 
registered automatically. 

4. The project information (Project menu -> Project Information) is not loaded to the 
target. To copy the information to application information fields, click Reset to values 
from project information. 

    Figure img14 
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Appending a new POU 
1. To append a new POU, right-click Application, select Add Object and then Add 

POU. 
2. On the Add POU menu, give a name for the POU and select the type of the POU and 

the used implementation language. 

 
Figure img16 

The appended POU, xxx (PRG) is added to the Devices tree under your application 
and the POU window with the declaration part and program code part is displayed.  

 



29 

 

 

Writing program code 

A program organization unit (POU) is a unit, object or area where you can write the 
program code. The units can be created either directly under the Applications in the 
Devices tree or in a separate POUs window (View ->POUs or click POUs in the lower-left 
corner).  

The POU includes a declaration part (the upper window) and a program code part (the 
lower window). There are two different types of views for the declaration part: a textual 
view and tabular view. You can switch between these views by clicking the buttons in the 
upper right corner of the window. 

      Figure icons 

 
Figure img15 
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Continuous function chart (CFC) program 
This example shows how to create a new project in the CFC implementation language. 

Adding elements 

1. In the Devices tree, select the xxx(PRG) under your application. 
2. On the View menu, select ToolBox. Use the ToolBox components to add a CFC 

scheme. 

        Figure img17 

If an empty ToolBox list is already displayed on the right side of the window, double-
click the xxx(PRG) to display the Toolbox and the POU window. 

3. To add, for example, SEL and AND elements (logic operators, functions), use the Box 
element in the ToolBox list. In the ToolBox list, click Box and move the mouse to the 
program code area and left-click. 

    Figure img18 
4. Enter in the name of the function or operand in the ??? field. 

You can also use Input Assistant to find the function, keyword, operator, etc. you wish 
to use. To start Input Assistant, click the white rectangle next to the ??? field or press 
F2. 

  Figure img19 
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Note: The number in upper right corner of the white box indicates the execution order 
of the function. 

 

5. To invert the input/output, right-click the input/output of the element and select 
Negate. 

 
Figure img20 

Setting the execution order of the elements 

Each element has its own execution order. The number in the upper right corner of the 
element  indicates the sequence in which the elements in a CFC network are executed in 
the on-line mode. Processing starts from the element with the lowest number, that is 0. 
Note that the sequence influences the result and must be changed in certain cases. 
 
1. Right-click the element where the execution order needs to be changed.  
2. On the displayed shortcut menu, select Execution Order, then Set Execution 

Order…, type the New Execution Order number and click OK. 

 
Figure img21 

The block execution order is changed. 
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Adding a comment to a CFC program 

1. In ToolBox, select Comment, then click the needed point in the program code area 
and enter the comment text. 

    Figure img22 

Declaring variables 

To create a new variable, you can either declare it in the declaration part of the editor 
window or use autodeclaration.  

Depending on the type of the declaration view (textual or tabular) you can add a new 
variable by writing its properties to a new text row (textual view) or using the TAB button 
(tabular view). For changing between the views, see Writing program code. 
1. Select the needed object in the program code area. 
2. Select Edit -> Auto Declare or press Shift + F2. The Auto Declare window opens. 

If you have enabled to declare unknown variables automatically (Tools -> Options -> 
SmartCoding), the Auto Declare window opens every time you use an unknown 
variable in your program and you can declare the variable instantly. 

 

Figure img23 

3. Define the Scope, Name and Type of the variable (mandatory). 
• The scope defines the type of use of the variable (global, input, output, etc.). 
• The name is a unique identifier of the variable. It should represent the purpose of 

the variable. 
• The type is the IEC data type of the variable. 

Optionally you can also define the Initialization value, Address, Comment or Flags 
for the variable. 
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The flags have the following meaning: 
• CONSTANT means that the variable value cannot be changed, that is, the 

variable maintains its initial value all the time. 
• RETAIN keeps its value over reboot and warm reset. 
• PERSISTENT is not supported! 

Adding inputs and the outputs 

You can add inputs and outputs by selecting them in ToolBox like the box elements. See 
section Adding inputs and the outputs. 

 
Figure img24 

Another way to add inputs and outputs straight to a block is to select a pin of a block and 
start typing the name of a variable.  
1. Select the pin of the block in the program code area. 
2. Name the input or output by writing the variable name to the block or use input 

assistant as described in Declaring variables. 
3. Connect the input or output block to a pin by left-clicking the line connected to the 

block and drag and drop it to a pin of another block. 
 

Creating a block scheme 

Example: 

Create the following CFC program: 

 
Figure img25 
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The following local variables are needed in the block scheme. 

    Figure img26 

During block scheme programming, the already created variables are displayed in the 
Input Assistant and new declarations are added to the variable declaration area. For 
using the Input Assistant, see section Adding elements in Continuous function chart 
(CFC) program. 

 
Preparing a project for download 

1. To prepare a project for download, click Build on the Build menu or press the F11 
key. 

2. On the View menu, select Messages or press Alt+2.   
3. In the Messages window, check that there are no errors or warnings. Otherwise, 

check and fix your application. 

 
Figure img27 

In the example, the process is successfully completed without any errors or warnings, 
and the project is ready for download. 
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Downloading the program to the drive 

After the project is ready for on-line communication with the drive, the written program 
can be downloaded and executed on the drive. Check that the active path to the target 
device has been defined in the communication settings. For more information, see 
section Establishing an on-line connection to the drive. 
1. On the Online menu, select Login or press Alt+F8. The following dialog is displayed 

because no program has been downloaded before. Click Yes. 

 

Figure img28 

 

For more information about download options, see section Application download options 
in chapter Features. 

After the download is completed, the background color of the device name and 
application name in the Devices tree changes to light green. The application status is 
shown in brackets [xxx] after the name. In the example it is [stop]. 

 

Figure img29 
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Executing the program 

1. To run the application, select Start on the Debug menu or press the F5 key. The 
application status changes to [run], showing that the program is executed 
successfully. 

 
Figure img30 

2. To set or change a value of an existing variable, double-click the cell in the Prepared 
value column, type a new value and press Enter. 

3. To apply the prepared value to the variable, select Write values on the Debug menu 
or press Ctrl+F7. 

or 

To force the prepared value to the variable, select Force values on the Debug menu 
or press the F7 key. 

or 

To unforce a forced value, select Unforce values on the Debug menu or press 
Alt+F7. 

The variable value is changed. The current variable values are displayed in the Value 
column and in the source code near the variable.  

4. To log out correctly, select Stop on the Debug menu or Shift+F8 and then select 
Logout on the Online menu or Ctrl+F8. 

Note: Debugging or performing on-line changes on a running drive may have unforeseen 
consequences and should be avoided. 
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Features  

What this chapter contains 

This chapter describes the features of CoDeSyS V3 that are supported by the Control 
Builder Plus. 

 
Device handling 

In the IEC programming environment, devices represent hardware. The device 
description file contains information about the target device (drive) from the programming 
point of view like the device identifier, compiler type and memory size. The ABB 
Automation Builder installation package installs the device description files automatically. 

There are two target control units: 
• ACS880_AINF_ZCU11_M_V3_5 for ZCU-xx control units 
• ACS880_AINF_BCU12_M_V3_5 for BCU-xx control units, where 

• ACS880 = drive type 
• AINF= firmware type (Primary control firmware) 
• ZCU11/BCU12 = control unit type (BCU-12 is used with high power drives.) 

Contact your ABB representative to ensure the control board type of your 
ACS880 drive. 

• M = Master device 
• V3_5 = CoDeSys environment main version.  

 
The device description may be updated later and a new file can be installed by means of 
the Device Repository object on the Tools menu. The system supervises that a project 
with an incompatible device description file cannot be loaded to the drive. 

5 
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Control builder plus shows detailed information of the device by selecting the Device in 
the tree and opening the information tab. See the figure below.  

 
Figure img6.1 

 
Device ID (1612 0001), Drive FW name (AINFX) and application interface version 
(3.0.0.1) must be equal in the project and drive target. Using the Drive composer pro 
System info, check that the drive target has the corresponding application interface 
version and device type and drive firmware name is displayed in parameter 7.04. In the 
Drive composer pro System info->Products/More, check that the drive has the 
corresponding application interface version and device ID.  

 
  Figure img30.1 

 

 
The Drive composer pro view shows also the name and version of the available actual 
system library. It must match the installed system library in the CBP project. 
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Upgrading or adding a new device 
You can upgrade or add a new device to the IEC programming environment. 
1. On the menubar, select Tools -> Device Repository… -> Install... 
2. In the Install Device Description window, browse and select the device description 

file (.devdesc.xml). 

Now you can add a new device to projects or upgrade currently existing devices in the 
project. 

Changing an existing device 
1. To change an existing device in a project, right-click the device in the Devices tree 

and select Update Device… or on the menu bar, select Project->Update Device. 

 
Figure img31 

The Update Device window opens. You can find other device types under 
Miscellaneous. You can display old installed device versions by selecting Display all 
versions (for experts only). 

2. In the Miscellaneous list, select the drive device. 
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Program organization units (POU) 

The POU types are: 
1. A program (PRG) may have one or several inputs/outputs. A program may be called 

by another POU but cannot be called in a function (FUN). It is not possible to create 
program instances. 

2. A function (FUN) has always a return value and may have one or several 
inputs/outputs. The functions contain no internal state information.  

3. A function block (FB) has no return value but may have one or several outputs as 
declared in the variable declaration area. A function block is always called using its 
instance and the instance must be declared in a local or global scope. 

 
A created project may have POUs with a specified implementation language. Each added 
POU has its own implementation language.  
 
For more detailed description of the POU types, see the IEC programming environment 
user manual and the IEC 61131-3 open international standard.
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Data types 

Note that the ABB drives embedded PLC does not support some of the standard IEC 
data types like BYTE, SINT, USINT, STRING. The following list gives the standard IEC 
data types, sizes and ranges. 

 

Data type Size 
(bits) 

Range Supported 
by BCU 

Supported 
by ZCU 

Notes 

BOOL 16* 0, 1 (FALSE, TRUE) Yes Yes  

SINT 8 -128...127 No No  

INT 16 -215...215-1 Yes Yes  

DINT 32 -231...231-1 Yes Yes  

LINT 64 -263...263-1 No Yes  

USINT 8 0...255 No No  

UINT 16 0...65535 Yes Yes  

UDINT 32 0...232 Yes Yes  

ULINT 64 0...264 Yes Yes  

BYTE 8 0.255 No No  

WORD 16 0...65535 Yes Yes  

DWORD 32 0...232-1 Yes Yes  

LWORD 64 0...264-1 Yes Yes  

REAL 32 -1.2*10-38...3.4*1038 Yes Yes  

LREAL 64 -2.3*10-308...1.7*10308 Yes Yes Slow. Do 
not use. 

TIME 32 0 ms... 
1193h2m47s295ms 

Yes Yes  

LTIME 64 0 ns...~213503d Yes Yes  

TOD 32 00:00:00...23:59:59 Yes Yes  

DATE 32 01.01.1970...~06.02.2106 Yes Yes  

DT 64 01.01.1970 00:00... 
~06.02.2106 00:00 

Yes Yes  

STRING[xx]  0...255 characters No No  

WSTRING[xx]  0...32767 characters Yes Yes  
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Application download options 

Before you can execute an application on the drive, it must be downloaded into the drive 
memory. Once downloaded, the application software is embedded in the firmware of the 
drive and has access to system resources.  

There are two different download options: 
• Download – a regular download method that copies the compiled application to the 

drive RAM memory. As a result, it is possible to execute the application, but after a 
power cycle or reboot the memory is erased. This download method does not alter an 
application that is located in the drive boot memory (ZMU) and the original application 
is available for use after a reboot. 
Note: To download a program to the RAM memory, the drive must be in the stopped 
mode. 

• Create boot application – a download method that copies the application to the non-
volatile memory of the drive memory card. This way the application remains intact 
after a power cycle or reboot. You need to be logged into the drive to perform this 
operation. Features that require restarting the drive to work must be downloaded with 
this method.  

Note: Firmware parameter mapping, task configuration, application parameters and 
event configuration are activated only after the boot application is loaded and the 
drive is booted. 

 
The create boot application command (Online -> Create boot application) includes 
also booting of the drive. Rebooting stops the execution of the whole drive firmware 
for a while. For this reason it is allowed only when the drive is stopped and start 
inhibition is granted for the CBP for this action. The following message is displayed to 
warn about rebooting. 

 
Figure img32 

 
Notes:  
• If the Reboot is not selected (No), the new application is, however, loaded to the drive 

permanent memory (ZMU) and the new program will be loaded after the next power 
off-on cycle. This may lead to unexpected behaviour of the drive for the user who is 
not aware of the changed application.   

• Ensure that stopping the execution of drive firmware and the application program 
does not have dangerous consequences for example, personal safety. An alternative 
method is to disconnect the power supply of the drive system and reconnect it again. 

• Start inhibition is not granted if the drive is running, disabled (DIL, Safety function 
active) or faulted. Make sure that these conditions do not exist before the program 
download.
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Removing the application from the target 

If the target already includes an application, we recommend using the Reset origin 
selection in the Online tab before downloading a new application. We recommend this 
especially if the application includes a lot of changes like application parameter changes 
or the application is replaced by another application.  

This command removes (clears all) old applications from the target and all the application 
related references. Use this command at least once before the “final” version of 
application is loaded. The command can be used only in the on-line mode. 
 

See also section Reset options. 

In the following dialog box, select Yes. 

Figure img33_1 

In the following dialog box, select Yes. The command is executed only if CBP gets the 
permission from the drive. 

Figure img33_2 
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Retain variables 

Retain variables are variables with the RETAIN flag. They can keep their value 
throughout the drive reboot and warm reset. A cold reset sets a retain variable to its initial 
value. The values of retain variables are cyclically stored in the flash memory of the drive 
and they are restored to the stored value after the restart of the program. The storing 
cycle period is 2…3 minutes. For that reason the recovered variable might not be the 
latest one if the value was changed after the last storing event. The retain variables are 
stored in a separate 256-byte memory area which defines the limits of their amount. 

Notes:  
• Retain variables are saved to the drive’s permanent memory periodically and 

therefore there is a risk that the latest values have not yet been saved if the drive has 
been shut down unexpectedly 

• If a local variable in a function block is declared as RETAIN, the complete instance 
of the function block is saved in the retain memory area. Avoid this to prevent running 
out of memory space because of large function block instances. 

Declaring a local variable in a function as RETAIN has no effect and the variable is not 
saved in the retain memory area. 

 
Task configuration 

Call configuration of the programs is handled by the task configuration object. A task is a 
project unit that defines which programs are called in the project and when. The projects 
can have more than one task with different time levels. (In the Devices tree, right-click 
Task Configuration -> Add Object -> Task.) 

There are three types of tasks available: 
• Cyclic (Task_1, Task_2 and Task_3) 
• Pre-task. 

Cyclic tasks are processed cyclically according to the task cycle time (Interval). The 
following table lists the time intervals available for cyclic application programs. The 
highest priority is given to the task with the shortest execution interval. 

 
Table 1: Configuration times for cyclic tasks 

Task Time interval 

Task_1 1 … 10 ms 

Task_2 10 … 100 ms 

Task_3 100 … 1000 ms 

 

If the program is configured as Pre_task, it is executed only once at start-up of the 
application program. This feature is useful for one time initializations. POU’s (blocks) 
assigned into this task, will be executed before cyclic tasks start running. 

The application program has its own quota of the CPU resources. If its limit is exceeded, 
the drive trips to task overflow fault (see ACS880 firmware manual). 
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Source code upload and download 

Optionally, the source code of the project may also be saved in the drive. This feature is 
located in File -> Source download… or Online -> Source download to connected 
device and it ensures that the files are easy to obtain if needed. To retrieve the saved 
source code from the drive, select File -> Source upload in an empty new project. 

Note: If the source code is saved on the ZMU memory unit, it is possible to retrieve the 
program with another PC without the authors consent unless the project is password-
protected. 

The size of the source code is limited to 500kB. Check the archiving option to minimize 
the source code size (File->Project Archive->Save/Send Archive…). Note that 
Referenced devices and libraries are needed, the rest is optional. 
 

Symbol files 

If the Symbol configuration object is added to the project (Application in the Devices 
tree -> Add object->Symbol configuration… or Project->Add object->Symbol 
configuration…), the IEC variable-to-symbol data is loaded into the drive during the 
Create boot application download. (See Application download options.) This feature 
provides Drive composer pro access to the application variables, which is very useful for 
graphical monitoring and debugging purposes. 

For more information on the Symbol configuration editor and adding variables, refer to the 
On-line help. 

 
Debugging and on-line changes 

The following debugging features and variable forcing are supported:  
• Start / stop program execution  
• Setting breakpoints 
• Stepping code line by line or by function 
• Forcing variables (constant setting of variable values) 
• Writing variables (single setting of variable values). 

On-line changes of the program code are not supported. 

Note: Setting breakpoints and forcing variable values on a running drive with a motor 
connected may have unforeseen and dangerous consequences and must be avoided. 



47 

 

 

Safe debugging 
Take special care when debugging the application program of a running drive in the on-
line mode. If you are not sure that the malfunction of the application does not cause 
safety risks, avoid the following actions when your drive is running a motor: 
• stopping the application program 
• setting breakpoints to the application program 
• forcing variable values. 

It is best, for example, to avoid assigning values to outputs, changing the values of a local 
variable in function blocks or assigning invalid input values. 

Breakpoints stop the entire IEC application, instead of just the task that has the currently 
active breakpoint. 

 
Reset options 

You can reset the application, using the reset selections on the Online tab: 
• Reset warm resets all variables of the currently active application to their initial 

values (except the retain and persistent variables). In case of specific initial values, 
the variables are reset exactly to those specific values. 

• Reset cold resets all variables (normal and retain) of the currently active application 
to their initial values. 

• Reset origin erases the application, downloaded to the drive from the RAM and the 
memory unit (Boot application). In case of specific initial values, variables are reset to 
those specific values. Drive firmware parameter mappings and user-defined 
parameters and events are also removed. Lastly, drive will be restarted. 

Note: The reset origin actions cannot be undone. 
 
1. To reset the current application in the on-line mode, select the application in the 

Devices tree and then Online-> the required reset method. 

 
Figure img34 

2. After the reset, you must restart the application (key F5). 
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Visualization 

You can run the visualization elements only within the Control Builder Plus tool. Target-
based visualization is not supported. 

You can access the drive data in the on-line mode from the visualization application and 
read and write variables with the visualized controls on the PC (Application -> Add 
object -> Visualization; for more information, see the CPB on-line help). 

 
Memory limits 

The build report shows the actual memory allocation. To see the effective size of the 
program, use Build -> Clean and Clean All to remove temporary code sections from the 
program. 

Memory area 0 is assigned for the code and data. Area 1 is for retain variables. 

 
Figure img35 

 

To optimize the memory consumption, avoid, for example, using function blocks and 
unnecessary variable definitions. 

 
CPU limitation  

The maximum execution load of the application is limited to a certain value (5…15%) 
depending on the drive type. Check the load limit from your local ABB representative. 

You can check the application load, using parameter 7.5 which monitors the CPU load. 
You can see the load difference by comparing the value with and without the application. 
The difference should not be greater than value limit.  

If the application exceeds the limit, the drive trips to the task overload fault. The fault is 
registered to the drive’s event log and the fault-specific AUX code indicates the 
overloaded tasks (10 = task 1, 11 = task 2 and 12= task 3). 

We recommend doing careful CPU load tests to ensure that the drive is capable of 
adequately running the application. For this purpose, enable as many as possible of the 
drive’s functions during the execution of the IEC application, for example, motor control, 
communication modules, encoders, and so on. 
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DriveInterface  

What this chapter contains 

This chapter describes how to implement DriveInterface and make input/output mapping 
between the IEC program and drive firmware parameters.  

 
Implementing DriveInterface 

The interface between the drive firmware and IEC application is easiest to implement 
using DriveInterface. 

 
Figure img6.1 
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DriveInterface has a list of all the drive firmware parameters that can be used in the IEC 
program. This list is specific for each drive firmware (a new firmware may have new 
parameters). You can assign a parameter to be an input for the application program and 
define that the parameter is read at the very beginning of the task execution. Similarly, 
user can assign parameters to be an output of the application. 

Figure img37 

Note: Parameter to IEC variable mappings become valid only at boot, so a reboot of the 
drive is required after the download. In other words, the boot application is the only way 
to use parameters in CoDeSys. See also Application download options. 

Selecting the parameter set 
A drive can have different parameters depending on the firmware version. Before 
performing parameter modification, ensure that the correct parameter set is selected in 
DriveInterface.   

Note: Changing the parameter set in DriveInterface removes all parameter mapping data.  
1. To change the currently selected parameter set, right-click DriveInterface in the 

Devices tree and select Plug Device.  
2. Select the correct parameter set for the current target. 

Parameter mapping report 
When you download the application program, a report of non solved parameter mappings 
between the project parameters and actual parameters in the drive is written in the PLC 
log. 

Figure img38 

For more about download, see Downloading the program to the drive and Application 
download options_Downloading_the_program_1.  
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Mapping example 
To read digital input DI1 of the ACS880 control unit to the previous CFC example 
(Creating a block scheme), open group 10 and select index 1. 
1. In the Devices tree, click DriveInterface. The Parameter Mapping window opens. 

 
Figure img39 

2. In the Parameter Mapping window, right-click the required Assignment cell and 
select Input in the drop-down list. 

  Figure img40 

3. Double-click the default IEC variable name 
ACS880_AINF_ZCU11_M_V3_5_DI1_10_1. A button is displayed to the right of the 
selected name. 

4. Click the button. The Input Assistant is displayed. 
5. Select existing variable DI1 from the POU variable list. DI1 is connected to drive 

parameter 10.1. DI status, bit 0. 

 

Figure img41 

After this the mapped parameters are is available as IEC variables in the program editors 
(press F2). 

Note: Bit and value pointer parameters can be used as outputs and then the pointer is 
linked directly to the application memory.  
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Updating parameter list 

1. To update the parameter list in DriveInterface, right-click Drive Interface and select 
Delete. 

2. Right-click DriveInterface again and select Plug Device. Now it is possible to change 
the parameters list of the DI. 

You can hide a parameter from the ACS-AP-x control panel and the Drive composer pro 
display: 
1. Select DriveInterface.  
2. In the upper-left corner of the Parameter Mappings window, select Settings and 

then the required Hide option for the corresponding parameter. 
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Application parameter and event 
creation 

What this chapter contains 

This chapter describes how to use ParameterManager and gives detailed information on 
parameter settings. 

 
ApplicationParametersandEvents 

You can create your own application parameters for the drive with the Control Builder 
Plus environment using the ApplicationParametersandEvents tool.  
 

     Figure img42 
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ParameterManager 

In the ParameterManager window, you can create new groups of parameters, parameter 
families, selection lists, units, events and language translations for the names of all the 
previous items. 

 
1. In the Devices tree/Application, double-click the ApplicationParametersandEvents 

object. The ParameterManager window opens. 

 
Figure img43 

Creating parameter groups 
All the parameters must belong to a parameter group hence before creating any new 
parameters you must create a new group. All the groups must have a unique name and 
number. You can change the group number and name. You can also add translations into 
other languages in addition to the default language which is English. 

1. In the ParameterManager window, click the Add Group button.  

ParameterManager automatically selects the first free parameter group number that is 
not yet used in the drive firmware or ParameterManager. 
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Creating parameters 
1. In the ParameterManager window, select a parameter group. 

2. To create a new parameter, click the Add Parameter button.  

The Parameter Settings window opens. In the window, you can set the properties of 
the parameter. The general settings window is the same for all the parameters but 
there are also custom settings available depending on the parameter type. For more 
information on the type-specific windows, see Parameter types. 

 
Figure img46 

Parameter names and types 

Parameter name is the name that is shown in the parameter list when using Drive 
composer or ACS-AP-x control panel.  

Parameter type defines which kind of parameter is created. There are following 
parameter types:  
• decimal number 
• formatted number 
• bit pointer 
• value pointer 
• plain value list and  
• bit list (16 bit).  

The types are described in more detail in Parameter types. 

You can also define an IEC variable name for the parameter. The New option maps the 
parameter to a new IEC variable. If you do not give a name for the new IEC variable, the 
parameter name is used as the IEC variable name.  

When you create a new IEC variable, you must select the variable type, for example, 
REAL. For more information on the variable types, see Data types in chapter Features. 
The selected parameter type restricts the variable type selection and only the allowed 
types are shown in the IEC variable/Type list.  

With the Existing option you can map the parameter to an already existing IEC variable 
by finding the parameter from the list the Input Assistant or writing the name to the field. 
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Parameter family 

Parameter family allows you to make the parameter a part of a parameter family and 
inherit the settings defined for the family. For more information, see Parameter Families. 

Function types 

Function types are flag configurations for parameters which determine the parameter 
behaviour with the ACS-AP-x control panel and PC tool displays. There are five different 
configurations: 
• Setting (adjustable) – a generic configuration parameter. When a parameter with 

this function type is changed by ACS-AP-x control panel or Drive composer, the 
changed value is saved. If the value is written cyclically, the saving type for the 
parameter must be no (for example, motor speed limits). 

• Setting (reverts to default) – The parameter is used by the user to request some 
function. The parameter returns to its default value when the request has been 
processed. 

• Signal (read only) – The parameter is used to display a value of an application 
parameter in the ACS-AP-x control panel or Drive composer. The parameter does not 
have any meaningful default value. 

• Signal (resettable) – The same as the read-only signal except that the user can reset 
the parameter to some default value (for example, resettable counters). 

• Custom – Both the application and the user can change the value. 

Saving types 

Saving types define the method of storing the parameter value to the non-volatile 
memory. There are three different saving types: 
• No – The parameter value is created by the application program and it is not stored to 

the non-volatile memory if changed by the ACS-AP-x control panel or Drive 
composer. 

• Powerfail – The parameter value is saved if a power down situation is detected. This 
saving type is good for continuously changing counters, and so on. It is not 
recommended for controls that do not change often. 

• Immediate – The parameter value is saved as it has been written. This saving type is 
good for controls and highly not recommended for signals. 

Protection, hiding and excluding from backup 

You can set the following protections for parameters or set them on the parameter group 
level by selecting a parameter group in ParameterManager. 
• Human WP/Human Hide write-protects/hides the parameter from a human user 

manipulation. This setting can be bypassed using configuration tools, fieldbus 
controllers, and so on. 

• Total WP/Total Hide write protects/hides the parameter from any kind of 
manipulation outside firmware. These parameters are meant to be used only by the 
application. 

The following settings are for the parameters only: 
• WP Run protects the parameter from writing when the drive is running. 
• Exclude from Backup leaves the parameter out of parameter backup. The 

parameter default restore is still performed. 
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Minimum, Maximum and Default value 

The minimum, maximum and default values are set for decimal and formatted numbers. 

Minimum and Maximum define the limits for the value of the parameter. These values 
cannot exceed the limits of the data type defined for the parameter. Default value is the 
value of the parameter at the start-up of the program and it must be inside the limits 
defined by the minimum and maximum values. The default value is returned if you restore 
defaults or clear all with parameter 96.06 Parameter restore (see the drive firmware 
manual). 

Parameter types 

Decimal number 

The decimal number parameter type is used to create a parameter with actual numeric 
contents, either decimal or non-decimal numbers. The available IEC types are REAL, 
UDINT, UINT, DINT and INT. 

Base value, Value (32-bit int) and Value (16-bit int) define how the parameter value is 
scaled in different contexts. Base value is the internal firmware value, Value (32-bit int) 
is the 32-bit external value (for example, for Drive composer or ACS-AP-x control panel) 
and Value (16-bit int) is the 16-bit external value (for example, for fieldbus devices).  

All these scaling values match each other and define how one certain value of the 
parameter is represented in the other contexts. Scaling for all the other values of the 
parameter is calculated on the basis of the scaling values defined. If you wish the scaling 
factor to be 1, which means direct transform from one representation to another, use the 
same number for all of these scaling values.  

Example: 

The firmware uses values 0…1 for motor rotation speed measurement. The maximum 
rpm is 1500, and therefore the ACS-AP-x control panel displays 1500 rpm when the 
internal value is 1.0 (the maximum speed). The 16-bit fieldbus device shows 100%. 

In this example the values are: 
Base value = 1.0 
Value (32-bit int) = 1500 
Value (16-bit int) = 100.0 

Decimal Display defines how many decimals are displayed on the Drive composer or 
ACS-AP-x control panel. This setting has no effect on the internal value, only on the 
displayed external value. 

16-bit interface support defines if the 16-bit external format is allowed, for example, in 
fieldbus devices and how it is scaled to the 32-bit external format: 
• No – the 16-bit external format is not allowed. 
• Direct – the 32-bit scaling is used but the value is displayed as a 16-bit value. 

Therefore, Value (16-bit int) is considered meaningless. 
• Scaled – separate 16-bit scaling is used. Value (16-bit int) must be defined. 
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Formatted number 

The formatted number parameter type is used to make special-purpose parameters like 
date displays, version texts, passcodes, and so on. The available IEC types are UDINT, 
UINT, DINT and INT. 

Display format for Data Parameter defines in what format the value is displayed on the 
Drive composer or ACS-AP-x control panel. 

 
Figure img47 

Bit pointer 

Bit pointer creates a pointer parameter which can be assigned to point to a bit of another 
parameter. You must associate the bit pointer parameter to a selection list (a bit pointer 
list) that must be created beforehand. For more information, see Selection Lists. The only 
available IEC type for bit pointer is BOOL. You can define the default selection from the 
list. 

    Figure img48 

Value pointer 

Value pointer creates a pointer parameter which can be assigned to point to another 
parameter. You must associate the value pointer parameter to a selection list (a value 
pointer list). For more information, see Selection Lists. The available IEC types for the 
value pointer are REAL, UDINT, UINT, DINT and INT. You can define the default 
selection from the list. 

Plain value list 

The parameter type Plain value list must be associated to a selection list (a plain value 
list) and it allows only values of the list as its own value. The available IEC types are 
UDINT, UINT, DINT and INT. You can define the default selection from the list. 
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Bit list (16 bit) 

A Bit list (16 bit) consists of maximum 16 Boolean values (bits). You can add new rows 
(bits) to the list using the Bitlist row button. You can change the names of the bits and 
their values to represent their purpose. The default value is the bit value at the start-up of 
the program. The only available IEC type is UINT. 

 

Figure img50 
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Parameter families 
If a parameter shares some of its attributes (scaling, minimum/maximum, and so on) with 
another parameter, it can belong to a family that describes these common attributes. This 
way, when the attribute is changed in one parameter, it is also changed in all parameters 
belonging to the same family.  

You can freely choose the parameter family Version style but the family must have a 
unique Name. The parameter families can define limit or scaling properties or both of 
them. 

 

Figure img51 
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Selection lists 
There are three different types of selection lists:  
• Bit pointer list – By default, it has the const_false and const_true values. You can 

add to the bit pointer list single bits of any parameter of the appropriate type. 
• Value pointer list – By default, it has the const_null value. You can add to the value 

pointer list any parameter which has the same data type as the pointer associated to 
the list. 

• Plain value list – You can add to the plain value list any values of types INT, DINT, 
UINT or UDINT. The type has to be the same as the type of the pointer associated to 
the list. 

Selection lists are always associated to a parameter of the same type as the list and they 
can be accessed only through the parameters.  

Selection list name – The text visible to the user. Note that the name is not the official 
text since the language translator just uses this text as a source when creating the official 
language texts. 

Value/Source par – The value of the list row. For the bit and value pointers, it is the 
index of the row in the list. For the value lists, it is an actual selectable value. 

List type – A Bit pointer list, Value pointer list or Plain value list. 

Inverted – When a bit /value is read from a source parameter, it is inverted /negated for 
output when the inverted flag is set. 

Units 
You can create own units for the application parameters. A unit has a unique number and 
a name. The allowed unit codes for the application program are 128…255. 

 You can add translations of the name into other languages. 

 
Figure img52 

The units are attached to parameters in the Add Parameter -> Parameter Settings 
window. 
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Application events 
You can configure your own application events (faults or warnings). The application 
program can then trigger the event and the event is registered to the drive’s event logger 
with a time stamp. This tool defines the event ID code, type and event name (with 
translation). 

In the Events dialog box, give the following information 
1. Name, in this example My Event. The event name is displayed on the ACS-AP-x 

control panel and in the Drive composer tools when the event is 
activated / deactivated. 

2.  Event Type, in this example fault. 

The following event types are supported: 
• 1 = Fault (Trips the drive.) 
• 2 = Warning (Is registered to the event logger.) 
• 3 = Pure event (Is registered to another logger.) 
3. Event ID, in this example D100. Each type of event has its numerical range (ID code). 

You can select the ID code within the range.  

Figure img53 

The event is activated by using the EVENT function block in the program code (ABB 
drives system library). Every event must have its own instance of the EVENT block. 

The EVENT function block must have the same ID code and type as defined in the 
previous dialog box. 
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Libraries 

What this chapter contains 

This chapter contains general information of the libraries and description of the ABB 
drives system and standard libraries. You can find more detailed information in Appendix 
– ABB drives system library and Appendix – ABB drives standard library. 

 
Library types 

The following libraries are installed by default in Control Builder Plus for drive 
programming. 

 
Default libraries: 
• ABB drives system library (AY1LB_System_ACS880_V3_5)   
• ABB drives standard library (AS1LB_Standard_ACS880_V3_5). 

 
Optional libraries: 
• All generic CoDeSys IEC-libraries (standard and util) can be installed, but ABB does 

not guarantee their correct functioning (Note the data type limitations described in 
Data types.). 
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The Library Manager controls and manages the library usage in the project. Each project 
has its own Library Manager which is added automatically when you create a new 
project.  

 

 
Figure img55 

 
ABB drives standard library contains the most common and useful functions and 
function blocks for drive control. All the functions are implemented locally using the 
Structured text language. The CoDeSys Util and Standard libraries include additional 
general purpose functions. 
 
ABB drives system library includes all the drive-specific functions to interface the IEC 
application with the drive firmware and I/O interface. This library has external 
implementation in the drive system software. 
 
Note: Check that the drive has the corresponding system library installed: 
1. In the Drive composer pro System info, select More in Products.  
2. Check that the Application System Library displayed in the Drive composer pro has 

the same library version as the Control Builder Plus project. If the versions are not the 
same, part of the library may be incompatible. 
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Adding a library into the project 

1. To add a Library Manager (library container) into the project, right-click Application in 
the Devices tree. 

2. Select Library Manager and then Open. The Library Manager 
opens.

 
Figure img55 

3. To add a library, click the Add library… link on the right side of the Library Manager 
window. 

4. Select the needed library and click OK. 

Figure img56 

The library has been successfully added. 

Figure img57 
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Creating a new library 

The IEC programming environment allows you to create your own libraries to be used in 
the projects. After starting the programming environment, a new library can be created 
with the New Project dialog. 

1. On the File menu, select New Project. 

          Figure img4 

2. In the dialog-window, click Empty project, type the library Name and Location, then 
click OK. The new library is added into the POUs tree.  

3. To add a new POU into the created library, select POUs on the View.  
4. Then right-click the project name, select Add Object, then POU. 
5. Give the new POU a name, for example, POU1. 
6. Select the type of the POU, for example, Function Block and the implementation 

language, for example, Structured Text (ST) and then click Add.  
7. Open the created POU and add the following code into the variables declaration 

window: 

      Figure img59 
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8. Add the following code into the code area: 

   Figure img60 

9. After the code is added all library objects must be checked before the library export. 
On the Build menu, select Check all Pool Objects. 

10. To use the created library in the future, select Project ->Project Information and fill 
in the following information on the created project: company, title and version. 

 

Figure img61 

11. After the information is added, it is possible to install this library directly to the Library 
Repository. On the File menu, select Save Project and Install into Library 
Repository.  

Or 

To save the library as a usual file, select Save Project as… on the File menu. 

Or 

To save the library as a compiled library file, select Save Project as Compiled 
Library on the File menu. 

Note: To protect the library source code, you must use a compiled library file. The non-
compiled library format does not protect the source code. 

 
Installing a new library 

If the needed library is not in the repository, it must be installed before use. 
1. To install a new library, open Library Manager and click Add library.  
2. In the displayed window, click the Library Repository… button and then the Install… 

button. 
3. In the displayed dialog, browse/select the needed compiled library, and click Open. A 

new library is installed into the Library Repository and is ready for use in the project. 
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Managing library versions 

Control Builder Plus allows you to use different versions of the selected library according 
to project requirements. 

 
1. To change the current effective library version, open Library Manager.  
2. Select the needed library and click the Properties… link on the right. 
3. Select the needed version and then click OK. The library version is changed and can 

be used in the 
project.

 

Figure img62 

If you wish to add a new library version that is not in the Specific version list, install the 
version first. See Installing a new library. 
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Practical examples and tips 

What this chapter contains 

This chapter gives practical examples and tips on working with Control Builder Plus.  

 
Solving communication problems 

Question: What to do when scan network does not find any 
drives?  
Answer 
• Check the communication settings.. 
• In Windows Computer Management -> Device Manager, check that your 

communication port is correctly installed. 

• If the USB Serial Port (COMX) is not displayed under Device Manager, check that 
the corresponding USB/communication port driver is installed. 

 
Figure img10 
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• To check that the OPC server (DriveDA.exe) has started in Windows Task Manager, 
select Ctrl + shift + esc -> Processes. 

 
Figure img11 

• Check that Drive composer pro (Drive OPC) finds the connection to the drive. 
 

• Note: To work in parallel with Drive composer pro, the register setting of the DriveDA 
OPC server is needed. This register setting is not included in the installation set-up of  
Automation builder version 1.0. You must make the following settings:  
4. Open regedit –program 
1. Search driveDA.dll (Find + F3) until you find key visible in fig, img 12 
2. Rename InprocServer32 to InprocServer.bak. 
3. Save change and close regedit 
 

• Also the reinstallation of the Drive composer pro adds a new InprocServer object to 
the registry. 

 

Figure img12
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Solving other problems 

Question: How to prevent unauthorized access to an application 
that is running in the drive? 
Answer 

A compiled project as well as the downloaded source code can be password-protected. 
You can make a backup copy of the protected application. The backup copy is encrypted 
and you need a password for downloading or executing the copied application. The IEC 
function libraries and projects can be protected as well by means of CoDeSys. 

Question: What to do if “The options could not be loaded. 
(Reason: Root element is missing.)” error message is displayed 
when I try to uninstall the software? 
Answer 

Remove the *.opt.* and *.opt files from the following locations: 
• Windows XP: 

• Program Files\3S CoDeSys\CoDeSys\Settings 
• Documents and Settings\<Username>\Application Data\CoDeSys 
• Documents and Settings \All Users\ Application Data\CoDeSys 
• <The project directory> 

• Windows Vista: 
• Program Files\3S CoDeSys\CoDeSys\Settings 
• Users\<Username>\ AppData\Roaming\CoDeSys 
• <ProgramData>\CoDeSys 
• <The project directory> 

• Windows 7 (64 bit) 
• Program Files (x86)\3S CoDeSys\CoDeSys\Settings 
• Users\<Username>\ AppData\Roaming\CoDeSys 
• ProgramData\CoDeSys 
• <The project directory> 

Question: How to fix an Unknown device in a project? 
Answer 

Install the desired device description to the device repository if you do not have it already. 
Then upgrade the device in the IEC project to the newly installed one, by right-clicking the 
device in the project and selecting Update Device…. 

Question: How to remove a boot application from the flash 
memory card? 
Answer 

Select Online -> Reset origin. Note that this removes the application permanently from 
the drive. Ensure that you have the source project available. 
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Question: What to do when I get an error message when I try to 
download a project to the target or try to create a boot 
application? 
Answer 

If the error message is not a compiler error because of an error in your program, clean 
the project compile information (Build -> Clean all) and then download the program 
again. If the error still persists, remove the previous application from the drive (Online -> 
Reset origin) and then download your program. 

Question: How to make a variable which keeps its value over the 
drive reboot? 
Answer 

Define the variable as a retain variable using the RETAIN flag. You can select the flag in 
the scope section or textually define the variable as in the screen shot below. For more 
information,  see section Retain variables in chapter Features. 

 

Figure img63 

Question: What to do when I continuously receive “The project 
handle 0 is invalid” error message? 
Answer 

There are two ways to get rid of the error: 
• Select Window -> Close All Editors and then restart CoDeSys. 

• Save the project into a new empty folder. 

     Figure img64 
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Question: What to do when stack overflow fault 6487 occurs? 
If stack overflow fault 6487 occurs, the number of the local variables inside a function is 
too large. Unfortunately the limit of the local variables is relatively small. The stack usage 
is high especially if there are, for example, division operands inside the EXPT function. 

Also if the division function’s divider is zero (an exceptional case), the stack usage is 
high.  

Answer 

First do not make too big functions at all. Try to make a compact function with a limited 
number of the variables (40 REAL). If the function is too large, change some of the local 
variables to global variables (use, for example, multiple global variable lists GVL to group 
variables by functions). Consider to use function blocks or program modules instead of 
functions. 

Question: How to optimize the memory usage of the drive 
application? 
The code memory of the application is running out. How to optimize the program? 

Answer  

The drive embedded PLC has relatively limited memory and execution capacity. You 
cannot compare that to real dedicated PLCs. There are a couple of tips to minimize the 
program code: 
• Use functions as much as possible. (Note: If there are too many variables inside the 

function, the risk of stack overflow increases.) 
• Try to design the application so that you do not need to create many instances of big 

function blocks. Instead of function blocks use programs or functions. 
• Use DriveInterface to access drive parameters instead of the parameter read / write 

functions 
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Appendix – Incompatible 
features between versions V3 
and V2.3 

What this chapter contains 

This chapter lists the features that are not compatible between CoDeSys versions V3 and 
V2.3 and gives some tips to solve possible problems. 

 
Incompatible features between CoDeSys versions V3 and V2.3 

• Unlike the newer version, CoDeSys V2.3 does not allow functions to have multiple 
outputs, thus the VAR_OUTPUT or VAR_IN_OUT tags cannot be included in the 
description part of functions. Converting the function into a function block solves this 
issue and provides an identical interface on both platforms at the cost of additional 
memory usage. 

• Single-line comments “//” are not supported in CoDeSys V2.3. Use block comments 
instead “(*…*)”.  

• Array initialization has different syntax. For this reason, it is not possible to have code 
that initializes an array to non-default values at declaration that is suitable for both 
versions. This can be solved by writing values to the array once right after the code is 
called. 

• Boolean operations are not allowed for integer types other than BYTE, WORD and 
DWORD in CoDeSys 2.3. 

• Namespaces are not supported in CoDeSys 2.3. 
• At least one statement is required for IF, ELSEIF and ELSE instructions in 

CoDeSys 2.3. 
• References are not supported in CoDeSys 2.3. Assigning a value directly instead of a 

reference can eliminate this limitation. 
• Unions are not available in CoDeSys 2.3. 
• Indexed access to variable pointers is not allowed in CoDeSys 2.3. For this reason, a 

pointer to the first element of an array cannot be used to access elements. Instead, 
the pointer needs to be declared as a pointer to an array of elements. For example: 
• ptr: POINTER TO ARRAY[0..10] OF REAL;  
• instead of ptr: POINTER TO REAL; to access ptr[5]. 

• In the newer CoDeSys versio, {attribute ‘hide_all_locals’} should be used to hide local 
variables, whereas the 2.3 version uses {library private}. These pragmas can be 
combined to produce code that works in both programming environments (only a 
warning is produced). 
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Appendix - Unsupported 
features of CoDeSys V3 

The ACS880 drives do not support the following standard CoDeSys V3 features: 
• Persistent variables, parameters or retain variables should be used instead 
• Target visualization 
• Target-based tracing. You can use the Monitor feature in Drive composer. See Drive 

composer user’s manual (3AUA0000094606 [English]). 
• BYTE, SINT, STRING and LREAL data types (The BOOL data type is internally 

converted to a 16-bit UINT in the ZCU target unit.) 
• The number of tasks is limited to 3. 
• Simulation  

 



79 

 

 

 



80 

 

 

Appendix – ABB drives system 
library 

What this chapter contains 

This appendix contains detailed information of the function blocks of the ABB drives 
system library (AS1LB_Standard_ACS880_.V3_5) 

 
Introduction to ABB drives system library 

The ABB drives system library is intended to be used with the ACS880 drives. It provides 
event, parameter read/write and program time level function blocks for application 
programming in the CoDeSys environment. The description of the features in this 
document is based on the ABB drives system library version 1.9.0.3. 

Note: Using the Drive composer pro System info, check that the drive has the 
corresponding system library installed. In the System info, the system library version is 
located under the Products/ More view. The system library versions must be the same in 
the drive and the IEC application program project. 
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Function blocks of the system library 

Function block name Description 

EVENT Send the application event. 

ReadEventLog Read the drive’s faults and warnings. 

ParReadBit Read the value of a bit in a packed-Boolean-type parameter. 

ParRead_DINT Read the value of a DINT/INT type parameter. 

ParRead_REAL Read the value of a REAL type parameter. 

ParRead_UDINT Read the value of a UDINT/UINT type parameter. 

ParWriteBit Write the value to a bit of a packed-Boolean-type parameter. 

ParWrite_DINT Write the value to a DINT/INT type parameter. 

ParWrite_REAL Write the value to a REAL type parameter. 

ParWrite_UDINT Write the value to an UDINT/UINT type parameter. 

ParRead_BitPTR Read the pointed bit value from a bit pointer type parameter. 

ParRead_ValPTR_DINT Read the pointed DINT/INT value from a value pointer type parameter. 

ParRead_ValPTR_REAL Read the pointed REAL value from a value pointer type parameter. 

ParRead_ValPTR_UDINT Read the pointed UDINT/UINT value from a value pointer type parameter. 

ParSet_BitPTR_IEC Set a bit pointer parameter to point to a bit type IEC variable. 

ParSet_ValPTR_IEC_DINT Set a value pointer parameter to point to a DINT type IEC variable. 

ParSet_ValPTR_IEC_REAL Set a value pointer parameter to point to a REAL type IEC variable. 

ParSet_ValPTR_IEC_UDINT Set a value pointer parameter to point to an UDINT type IEC variable. 

ParSet_BitPTR_Par Set a bit pointer parameter to point to a bit of a packed Boolean parameter. 

ParSet_ValPTR_Par Set a value pointer parameter to point to a value parameter. 

UsedTimeLevel Show time level (ms) of the program where the function block is located. 
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Event function blocks 

EVENT 
Summary 

The application event function block is used to trigger a 
predefined event (fault/warning/pure) from the IEC code. The 
event is registered to drive event logger.  

Connections 

Inputs: 
Name Type Value Description 

AuxCode DWORD  The auxiliary code that you can set freely (constant). 

Enable BOOL  Enable/disable event sending. 

EventType WORD  Type of the event (constant, cannot be changed on run 
time). Supported event types: Fault = 1, Warning = 2, 
Pure = 8 (Notice is not supported). 

ID WORD  Identification of the event (constant, cannot be 
changed on run time). This is a unique value of the 
event. You can find the supported values in the 
ApplicationParametersAndEvent tool. A certain range 
is reserved for each application event type. 

Trig BOOL  The high level (TRUE) of this pin sends/activates the 
event, if Enable is set to TRUE.  . Warning is 
deactivated automatically, when Trig falls down. To 
clear fault the reset command must be given. 

Outputs: 
Name Type Value Description 

Err WORD  The value is typically 0x0000.  

0x0001 = Not used  
0x0002 = Event is not user-defined event 
0x0003 = Event type error 
0x0004 = Event ID type error 
0x0005 = Not used 
0x0006 = Unknown event type 

Description 

You can configure an application event with the ApplicationParametersandEvents in 
Control Builder Plus tool. (See chapter Application parameter and event creation). This 
tool defines the ID and the event text (description). 

Control Builder Plus supports the following event types: Fault, Warning and Pure (or 
none).  
The event ID, text, auxiliary code, time and operation data is registered into the drive 
event logger. 
The application events can be shown using the ACS-AP-x control panel and Drive 
composer tools, or using the ReadEventLog block on the application level. Fault can be 
reset e.g. using control panel or Drivecomposer Pro tool. 
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ReadEventLog 

Summary 

ReadEventLog is a special block for reading faults and 
warnings from the drive event system. The block does not 
read events or use the drive event or fault loggers. 
Instead it gets the events straight from the event system 
itself.  

The purpose of the block is to forward drive events, for 
example, to external systems, like automation user interfaces. 

Inputs: 
Name Type Value Description 

Cnt UINT  Number of the wanted events at a time. ( 0…6 ) 

Enable BOOL  Enable / disable the block execution. The falling edge of 
this pin clears all the output vectors. 

EventType UINT  Not used. The block returns the drive’s faults and 
warnings. Can be set to 0. 

Index UINT  Not used. Can be set to 0. 

Outputs: 
Name Type Value Description 

AuxCode Array of 
UINT[10] 

 Auxiliary code of the event. 

Code Array of 
UINT[10] 

 Event code (ID). The block supports maximum 6 events at 
a time. 

Err UINT  Not used. 

EventLostCnt UINT  The number of the lost events (for monitoring). 

RdCnt UINT  The number of the get/read events at a time.  

Maximum 6  
RdCnt value = 0 indicates that there are no new events. 

Status Array of 
UINT[10] 

 Status of the event.  

1 = The event has been activated. 
2 = The event has been deactivated. 
3 = Acknowledgement requested. 
4 = The event is reactivated (warnings). 
5 = All faults have been deactivated. 
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Description 

The block packs the event Code, AuxCode and Status to vectors that the user can read. 
The block does not sort faults and warnings from each other. The 1st event in the vector is 
the oldest one. 

The block returns the maximum Cnt number of events in each execution cycle depending 
on how many events exist at this time on the drive. RdCnt indicates how many events are 
got in each execution cycle. The vectors and RdCnt are updated in every execution cycle 
if new events exist. For this reason, only the value of RdCnt matters when reading the 
event data from vectors. The older events are overwritten by the newer ones.  

Example:  

In the 1st execution cycle, the user reads 2 events, for example, events 11, 12 
(RdCnt = 2). Both are valid. 12 is the last one. 

In the 2nd execution cycle, the user reads 1 event, for example, 21 (RdCnt = 1). 

Now values 21, 12 can be seen in the Code vector, but because RdCnt is 1, only 
the first value is valid (21). (12 read in the previous cycle.) 

Vectors are cleared only on the falling edge of the Enable pin. 

EventLostCnt indicates the number of the lost events. The value should be 0. In 
the opposite case, the reason can be too slow execution cycle of this block. 

We recommend, however, that the execution cycle of this block is as slow as 
possible, and, for optimizing the application resources, there should be only one 
instance of this block in use. 

 



85 

 

 

Parameter read function blocks 

ParReadBit 
Summary 

ParReadBit reads the value of a bit in a packed Boolean type 
parameter.  

Connections 

Inputs: 
Name Type Value Description 

BitNro INT ANY Bit number 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output BOOL T/F Output value 

Description 

The function block reads the value of a bit in a packed Boolean type parameter. Group 
and Index define the parameter to be read and BitNro defines the number of the bit. The 
value of the bit read is returned from Output.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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ParRead_DINT 
Summary 

ParRead_DINT reads the value of a DINT/INT type parameter.   

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output DINT ANY Output value 

Description 

The function block reads the value of a DINT or INT type parameter. Group and Index 
define the parameter to be read. The value of the parameter is returned from Output. The 
type of Output is DINT even if the parameter to be read is of the INT type.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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ParRead_REAL  
Summary 

ParRead_REAL reads the value of a REAL type parameter.   

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output REAL ANY Output value 

Description 

The function block reads the value of a REAL type parameter. Group and Index define 
the parameter to be read. The value of the parameter is returned from Output.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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ParRead_UDINT 
Summary 

ParRead_UDINT reads the value of a UDINT/UINT type 
parameter.    

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output UDINT ANY Output value 

Description 

The function block reads the value of a UDINT or UINT type parameter. Group and Index 
define the parameter to be read. The value of the parameter is returned from Output. The 
type of the output is UDINT even if the parameter to be read is of the UINT type.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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Parameter write function blocks 

ParWriteBit 
Summary 

ParWriteBit writes a value to a bit of a packed Boolean type 
parameter.  

Connections 

Inputs: 
Name Type Value Description 

BitNro INT ANY Bit number 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Input BOOL T/F Input value 

Store BOOL T/F Store input 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block writes the value of Input into a selected bit of a packed Boolean type 
parameter. Group and Index define the parameter to be written and BitNro define the 
number of the bit. Store defines if the current written value of the parameter is stored to 
the flash memory. During the power-up of the drive, the value of the parameter is set to 
the latest stored value.  

Err returns an error code if there is an error during the write operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the write operation is 
successful, Err returns a 0. 
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ParWrite_DINT  
Summary 

ParWrite_DINT writes a value to a DINT/INT type parameter.   

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Input DINT ANY Input value 

Store BOOL T/F Store input 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block writes the value of Input into a selected DINT or INT type parameter. 
The type of the Input is DINT even if the parameter to be written is of the INT type. Group 
and Index define the parameter to be written. Store defines if the current written value of 
the parameter is stored to the flash memory. During the power-up of the drive, the value 
of the parameter is set to the latest stored value.  

Err returns an error code if there is an error during the write operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the write operation is 
successful, Err returns a 0. 
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ParWrite_REAL 
Summary 

ParWrite_REAL writes a value to a REAL type parameter.    

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Input REAL ANY Input value 

Store BOOL T/F Store input 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block writes the value of Input into a selected REAL type parameter. Group 
and Index define the parameter to be written. Store defines if the current written value of 
the parameter is stored to the flash memory. During the power-up of the drive, the value 
of the parameter is set to the latest stored value.  

Err returns an error code if there is an error during the write operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the write operation is 
successful, Err returns a 0. 
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ParWrite_UDINT 
Summary 

ParWrite_UDINT writes a value to a UDINT/UINT type 
parameter.    

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Input UDINT ANY Input value 

Store BOOL T/F Store input 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block writes the value of Input into a selected UDINT or UINT type 
parameter. The type of Input is UDINT even if the parameter to be written is of the UINT 
type. Group and Index define the parameter to be written. Store defines if the current 
written value of the parameter is stored to the flash memory. During the power-up of the 
drive, the value of the parameter is set to the latest stored value.  

Err returns an error code if there is an error during the write operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the write operation is 
successful, Err returns a 0. 
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Pointer parameter read function block 

ParRead_BitPTR 
Summary 

ParRead_BitPTR reads the pointed bit value from a bit pointer 
type parameter.  

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err WORD ANY Error output 

Output BOOL ANY Output value 

Description 

The function block reads the pointed value of a bit pointer type parameter. Group and 
Index define the pointed parameter to be read. The pointed value of the parameter is 
returned from Output.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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ParRead_ValPTR_DINT 
Summary 

ParRead_ValPTR_DINT reads a pointed DINT/INT value 
from a value pointer type parameter.  

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output DINT ANY Output value 

 

Description 

The function block reads the pointed value of a DINT or INT pointer type parameter. 
Group and Index define the pointed parameter to be read. The pointed value of the 
parameter is returned from Output. The type of Output is DINT even if the parameter type 
is INT.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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ParRead_ValPTR_REAL 
Summary 

ParRead_ValPTR_REAL reads a pointed REAL value 
from a value pointer type parameter.  

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output REAL ANY Output value 

Description 

The function block reads the pointed value of a REAL pointer type parameter. Group and 
Index define the pointed parameter to be read. The pointed value of the parameter is 
returned from Output.  

Err returns an error code if there is an error during the read operation, for example,  the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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ParRead_ValPTR_UDINT 
Summary 

ParRead_ValPTR_UDINT reads a pointed UDINT/UINT 
value from a value pointer type parameter.   

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

Output UDINT ANY Output value 

Description 

The function block reads the pointed value of a UDINT or UINT pointer type parameter. 
Group and Index define the pointed parameter to be read. The pointed value of the 
parameter is returned from Output. The type of Output is UDINT even if the parameter 
type is UINT.  

Err returns an error code if there is an error during the read operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the read operation is 
successful, Err returns a 0. 
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Set pointer parameter to IEC variable function blocks 

ParSet_BitPTR_IEC 
Summary 

ParSet_BitPTR_IEC sets a bit pointer parameter to point to a 
bit type IEC variable.  

Connections 

Inputs: 
Name Type Value Description 

BitNro INT 0 Bit setting is not supported. 

Group INT ANY Parameter group 

IEC_Var BOOL T/F IEC variable 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block sets a bit pointer type parameter to point to an IEC variable of the 
Boolean type, that is, the IEC variable overwrites the value of the bit pointer. The 
parameter to point must be of the bit pointer type. Group and Index define the parameter. 
The BitNro input must be set to zero since (at least in this library version) the type of 
IEC_Var must be Boolean and type of the parameter to be set must be bit pointer. 
Therefore the bit number cannot be chosen. The IEC_Var input is the IEC variable to be 
pointed.  

Err returns an error code if there is an error during the set operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the set operation is 
successful, Err returns a 0. 
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ParSet_ValPTR_IEC_DINT 
Summary 

ParSet_ValPTR_IEC_DINT sets a value pointer 
parameter to point to a DINT type IEC variable.  

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

IEC_Var DINT ANY IEC variable 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block sets a value pointer type parameter to point to an IEC variable of the 
DINT type, that is, the IEC variable value overwrites the value of the value pointer. The 
parameter to point must be a value pointer to the DINT or INT type. Group and Index 
define the parameter. The IEC_Var input is the IEC variable to be pointed.  

Err returns an error code if there is an error during the set operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the set operation is 
successful, Err returns a 0. 
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ParSet_ValPTR_IEC_REAL 
Summary 

ParSet_ValPTR_IEC_REAL sets a value pointer 
parameter to point to a REAL type IEC variable.  

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

IEC_Var REAL ANY IEC variable 

Index INT ANY Parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block sets a value pointer type parameter to point to an IEC variable of the 
REAL type, that is, the IEC variable value overwrites the value of the value pointer. The 
parameter to point must be a value pointer to the REAL type. Group and Index define the 
parameter. The IEC_Var input is the IEC variable to be pointed.  

Err returns an error code if there is an error during the set operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the set operation is 
successful, Err returns a 0. 
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ParSet_ValPTR_IEC_UDINT 
Summary 

ParSet_ValPTR_IEC_UDINT sets a value pointer 
parameter to point to a UDINT type IEC variable.  

Connections 

Inputs: 
Name Type Value Description 

Group INT ANY Parameter group 

IEC_Var UDINT ANY IEC variable 

Index INT ANY Parameter index 

Outputs: 

 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block sets a value pointer type parameter to point to an IEC variable of the 
UDINT type, that is, the IEC variable value overwrites the value of the value pointer. The 
parameter to point must be a value pointer to the UDINT or UINT type. Group and Index 
define the parameter. The IEC_Var input is the IEC variable to be pointed.  

Err returns an error code if there is an error during the set operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the set operation is 
successful, Err returns a 0. 
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Set pointer parameter to parameter function blocks 

ParSet_BitPTR_Par 
Summary 

ParSet_BitPTR_Par sets a bit pointer parameter to point to a 
bit of a packed Boolean parameter.  

Connections 

Inputs: 
Name Type Value Description 

S_BitNro INT ANY Source bit number 

S_Group INT ANY Source parameter group 

S_Index INT ANY Source parameter index 

T_Group INT ANY Target  parameter group 

T_Index INT ANY Target  parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block sets a bit pointer parameter to point to a bit of a packed Boolean type 
parameter. S_Group and S_Index define the parameter to be pointed (the source) and 
S_BitNro defines the number of the bit. T_Group and T_Index define the pointer 
parameter (the target) which points to the source parameter. The target parameter must 
be a Bit Pointer type and the source parameter must be a packed Boolean type.  

Err returns an error code if there is an error during the set operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the set operation is 
successful, Err returns a 0. 
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ParSet_ValPTR_Par 
Summary 

ParSet_ValPTR_Par sets a value pointer parameter to point 
to a value parameter.  

Connections 

Inputs: 
Name Type Value Description 

S_Group INT ANY Source parameter group 

S_Index INT ANY Source parameter index 

T_Group INT ANY Target  parameter group 

T_Index INT ANY Target  parameter index 

Outputs: 
Name Type Value Description 

Err INT ANY Error output 

 

Description 

The function block sets a value pointer parameter to point to a value parameter. S_Group 
and S_Index define the parameter to be pointed (the source). T_Group and T_Index 
define the pointer parameter (the target) which points to the source parameter. The target 
parameter must be a pointer parameter of the same type as the source parameter which 
must be a value parameter.  

Err returns an error code if there is an error during the set operation, for example, the 
parameter is not found or it is a parameter of a wrong type. If the set operation is 
successful, Err returns a 0. 
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Task time level function block 

UsedTimeLevel 
Summary 

UsedTimeLevel shows the time level (ms) of the program (task 
execution cycle) where the function block is located.  

Connections 

Inputs: 
Name Type Value Description 

NONE 

Outputs: 
Name Type Value Description 

Output INT ANY Used time level in ms 

 

Description 

The function block shows the time level of the program (task cycle) in which the particular 
function block is located. Output gives the time level in milliseconds. 
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List of error codes 

The following list gives the most common error codes related to the function blocks of the 
ABB drives system library. The error codes are received from the Err output and they 
indicate if there is an error during the performance of the function block. 

 
Error code number Description 

0 (hex 0) Success, no error 

4 (hex 4) The parameter is write-protected. 

5 (hex 5) The parameter is hidden. 

6 (hex 6) Illegal operation, for example, the parameter type is incorrect. 

9 (hex 9) Parameter minimum value is exceeded. 

10 (hex A) Parameter maximum value is exceeded 

11 (hex B) No value in the list 

13 (hex D) The parameter is not found. 

774 (hex 306) Outside index area 

775 (hex 307) Overlapping group 

777 (hex 309) UFF error 
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Appendix – ABB drives standard 
library 

What this chapter contains 

This appendix contains detailed information of the basic and special functions of the ABB 
drives standard library (AS1LB_Standard_ACS880_.V3_5) 

 
Introduction to ABB drives standard library 

The ABB drives standard library is intended to be used with the ACS880 drives and the 
AC500 PLC. It provides frequently used control elements for application programming in 
CoDeSys. Unlike the standard libraries provided by 3S-Smart Software Solutions, most of 
the function blocks in the library use floating point numbers. This provides a more flexible 
development environment as the programmer does not need to worry about handling 
wide numerical ranges and scaling. 

The drive version of the library is generated from the PLC version to ensure that the code 
is not altered in any way. For compatibility, some functions are implemented as function 
blocks because the PLC does not support multiple outputs for functions. The functions do 
not have a state and thus require less memory. This is also why the drive version of the 
library has these blocks as functions (that is, there are 2 versions available in the drive 
version). 

Input values are checked to be within the defined limits. If for some reason the block 
detects that a value is out of range, it can: 

1. Limit the value to the maximum or minimum value. For example, if the time constant 
is set to a very large value or a negative value, it is limited inside the block to ensure 
the correct execution. 

2. Produce an error signal. For example, if the low limit for the output is greater than the 
high limit, the block cannot operate and produces an error. 

The function blocks with a state have a balance reference and balance mode. This 
feature provides the means to force the control system to a new state. By enabling the 
balance mode, the blocks operate as if the balance reference is the calculated output of 
the block. Internal variables are also adjusted so that once the balance mode is disabled 
the process continues from the balance reference value. 
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Basic functions 

BGET 
Summary 

The BGET function reads one selected bit from a WORD 
or a DWORD (includes size check).  

Connections 

Inputs: 
Name Type Value Description 

BIT_NR UINT 0…31 Bit number 

IN DWORD, 
WORD 

ANY Data input 

Outputs: 
Name Type Value Description 

BGET BOOL TRUE, 
FALSE 

Bit value 

 

Function 

The output (BGET) is the selected bit (BIT_NR) of the input word (IN). 

If BIT_NR is 0, the bit is 0. If BIT_NR is 31, the bit is 31. 

If the bit number is not within the range of 0…31 (for DWORD) or 0…15 (for WORD), the 
output is 0. 
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BSET 
Summary 

The BSET function changes the state of one selected 
bit of a WORD or a DWORD (includes size check).  

Connections 

Inputs: 
Name Type Value Description 

BIT_NR UINT 0…31 Bit number 

BIT_VALUE BOOL TRUE, 
FALSE 

New value for bit 

EN BOOL TRUE, 
FALSE 

Enable block 

IN DWORD, 
WORD 

ANY Data input 

Outputs: 
Name Type Value Description 

BSET DWORD, 
WORD 

ANY Changed word 

 

Function 

The value of a selected bit (BIT_NR) of the input (IN) is set as defined by the bit value 
input (BIT_VALUE).  

If BIT_NR is 0, the bit is 0.  If BIT_NR is 31, the bit is 31. The function must be enabled 
by the enable input (EN). 

If the function is disabled or the bit number is not within the range of 0…31 (for DWORD) 
or 0…15 (for WORD), the input value is stored to the output as it is (that is, no bit setting 
occurs). 

Example: 

EN = 1, BIT_NR = 3, BIT_VALUE = 0 

IN = 0000 0000 1111 1111 

BSET = 0000 0000 1111 0111 
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DEMUX 
Summary 

The demultiplexer function block is available with 2, 4 and 8 
inputs for the BOOL, DINT, INT, REAL and UDINT data types. 

Since the block does not need internal memory, it also comes as 
a function (CoDeSys for PLC does not support multiple outputs 
for functions).  

Connections 

Inputs: 
Name Type Value Description 

ADDR UINT 1…8 Address 

IN BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Input 

Outputs: 
Name Type Value Description 

OUT1…8 BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Output 1…8 

 

Function 

 
The input value (IN) is stored to the output (OUT1…8) selected by the address input 
(ADDR). All other outputs are set to 0. 
 
If the address input is not from 1 to 8, all outputs are set to 0. 
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DEMUXM 
Summary 

The demultiplexer function block with an internal memory to 
store output values is available with 2, 4 and 8 inputs for the 
BOOL, DINT, INT, REAL and UDINT data types. 

 

Connections 

Inputs: 
Name Type Value Description 

ADDR UINT 1…8 Address 

IN BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Input 

LOAD BOOL TRUE, 
FALSE 

Load (Set only once) 

RESET BOOL TRUE, 
FALSE 

Reset 

SET BOOL TRUE, 
FALSE 

Set 

Outputs: 
Name Type Value Description 

OUT1…8 BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Output 1…8 

 

Function 

 
DEMUXM is used as a demultiplexer with memory. It remembers the assigned values to 
outputs and continues sending them until changed or reset. 
 
The input value (IN) is stored to the output (OUT1…8) selected by the address input 
(ADDR) if the load input (LOAD) or the set input (SET) is 1. 
 
When the load input is set to 1, the input value is stored to the output only once. When 
the set input is set to 1, the input value is stored to the output every time the block is 
executed. The new set input overrides the load input. 
 
If the address input is not from 1 to 8, the outputs are not affected by the input value. 
If RESET = 1, all outputs are set to 0 and the block’s memory is reset. 
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MUX 
Summary 

The multiplexer function for the REAL data type as the 
CoDeSys version does not support this type. The function 
block is available with 2, 4 and 8 inputs.  

Connections 

Inputs: 
Name Type Value Description 

ADDR UINT 1…8 Address 

IN1…8 REAL ANY Inputs 1…8 

Outputs: 
Name Type Value Description 

MUX REAL ANY Selected input value 

 

Function 

 
The value of an input (IN1…8) is selected by the address input (ADDR) and stored to the 
output (MUX). 
 
If the address input is not from 1 to 8, the output is set to 0. 
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MUXM 
Summary 

The multiplexer function block with an internal memory to store the 
output is available with 2, 4 and 8 inputs for the BOOL, DINT, INT, 
REAL and UDINT data types.  

 

 

Connections 

Inputs: 
Name Type Value Description 

ADDR UINT 0…8 Address 

IN1…8 BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Inputs 1…8 

LOAD BOOL TRUE, 
FALSE 

Load 

RESET BOOL TRUE, 
FALSE 

Reset 

SET BOOL TRUE, 
FALSE 

Set 

Outputs: 
Name Type Value Description 

OUT BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Output 

 

Function 

 
MUXM is used as a multiplexer with a memory. It remembers the assigned value of the 
output and continues sending it until changed or reset. 
 
The value of an input (IN1…8) is selected by the address input (ADDR) and is stored to 
the output (MUX) if the LOAD input or the SET input is 1. 
 
When the load input is set to 1, the input value is stored to the output only once. When 
the set input is set to 1, the input value is stored to the output every time the block is 
executed. The new set input overrides the load input. 
 
If the address input is not from 1 to 8, the output is not affected by input value. If 
RESET = 1, the output is set to 0 and the block’s memory is reset. 
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PACK 
Summary 

The PACK function sets the BOOL inputs into a WORD or a 
DWORD.  

 

 

 

 

 

 

 

Connections 

Inputs: 
Name Type Value Description 

IN0…31 BOOL TRUE, 
FALSE 

Bits 

Outputs: 
Name Type Value Description 

PACK WORD, 
DWORD 

ANY Resulting pack of bits 

 

Function 

 
The Pack function takes an input set of bits and packs it in to a word. 
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SR_D 
Summary 

The SR-D function block is an extension to a normal SR trigger 
with an additional memory input D trigger. The Reset signal 
overrides all other control signals and clears the internal block 
state. The Set signal forces the output to the TRUE state.  

Connections 

Inputs: 
Name Type Value Description 

CLK BOOL TRUE, 
FALSE 

Clock, rising edge active 

DATA BOOL TRUE, 
FALSE 

Data Input 

RESET BOOL TRUE, 
FALSE 

Reset 

SET BOOL TRUE, 
FALSE 

Set Input 

Outputs: 
Name Type Value Description 

OUT BOOL TRUE, 
FALSE 

Output signal 

 

Function 

 
The SR-D block implements D trigger with the SET, RESET controls. The data is stored 
from D input when the clock changes from 0 to 1. The SET signal forces the output to the 
TRUE state. If R is active, the output is always FALSE. The RESET signal overrides all 
other control signals and clears the internal block state. 
 
When the clock input (CLK) is set from 0 to 1, the DATA input value is stored to the 
output (OUT). 
 
When RESET is set to 1, the output is set to 0. 
 
Truth table: 

SET RESET DATA CLK Previous output OUT 

Any 1 Any Any Any 0 

1 0 Any Any Any 1 

0 0 Any 0 Qn-1 Qn-1 

0 0 0 0->1 Any 0 

0 0 1 0->1 Any 1 
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SWITCH 
Summary 

The SWITCH function block sets the outputs the same as the 
input  if EN equals TRUE, otherwise all outputs are 0. SWITCH 
is available with 2, 4 and 8 inputs and outputs for the BOOL, 
DINT, INT, REAL and UDINT data types. 

Since the block does not need internal memory, it also comes 
as a function (CoDeSys for PLC does not support multiple 
outputs for functions). 

Connections 

Inputs: 
Name Type Value Description 

EN BOOL TRUE, 
FALSE 

Enable 

IN1…8 BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Input 1…8 

Outputs: 
Name Type Value Description 

OUT1…8 BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Output 1…8 

 

Function 

 
The output (OUT1…8) is equal to the corresponding input (IN1…8) if the block is enabled 
(EN = 1). Otherwise the output is 0. 
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SWITCHC 
Summary 

The SWITCHC function block has two channels. A channel can 
be chosen by using the Select signal. If Select equals FALSE, 
channel A is active. If Select equals TRUE, channel B is active. If 
the EN signal is not active, all outputs are 0. SWITCHC is 
available with 2, 4 and 8 input pairs and outputs for the BOOL, 
DINT, INT, REAL and UDINT data types. 

Since the block does not need an internal memory, it also comes 
as a function (CoDeSys for PLC does not support multiple 
outputs for functions).  

Connections 

Inputs: 

Name Type Value Description 

EN BOOL TRUE, 
FALSE 

Enable 

IN1…8A BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Input A 1…8 

IN1…8B BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Input B 1…8 

SELECT BOOL TRUE, 
FALSE 

Select 

Outputs: 
Name Type Value Description 

OUT1…8 BOOL, DINT, 
INT, REAL, 
UDINT 

ANY Output A 1…8 

 

Function 

 
The output (OUT1…8) is equal to the corresponding channel A input (IN1…8A) if the 
activate input signal (SELECT) is 0. The output is equal to the corresponding channel B 
input (IN1…8B) if the activate input signal (SELECT) is 1. 
 
If the block is disabled (EN = 0), all outputs are set to 0. 
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UNPACK 
Summary 

The UNPACK function block splits a WORD or a DWORD into a 
set of BOOL outputs.  

Since the block does not need an internal memory, it also 
comes as a function (CoDeSys for PLC does not support 
multiple outputs for functions). 

 

Connections 

Inputs: 

 

Name Type Value Description 

IN WORD, 
DWORD 

ANY Input data 

Outputs: 
Name Type Value Description 

OUT0…31 BOOL TRUE, 
FALSE 

Output bits 

 

Function 

 
The Unpack function takes an input word and returns it as a set of bits. 
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Special functions 

Drive control 
Summary 

The drive control program offers basic 
controls of an ACS880 drive for 
application programmers. A similar 
function block for the PLC to control the 
drive exist is in the PS553 library. 

 

Connections 

Inputs: 

Name Type Value Description 

EN BOOL TRUE, 
FALSE 

Enable function block - TRUE. Additionally configures 
the drive to use the application program.  

See parameters 19.11, 20.1, 20.6, 22.11 and 26.11. 

EXT_CTRL_LOC BOOL TRUE, 
FALSE 

Selects external control location (EXT1/EXT2).  

See parameters 6.2.11 and 19.11. 

REF_VALUE2 REAL ANY Torque reference value. 

See parameter 26.11. 

RESET BOOL TRUE, 
FALSE 

Resets drive and internal parameter errors.  

See parameter 6.2.7. 

SPEED_REF REAL ANY Speed reference value.  

See parameter 22.11. 

START BOOL TRUE, 
FALSE 

TRUE = start drive 

FALSE = stop along currently active stop ramp. 

See parameter 6.2.0. 

STOP_COAST BOOL TRUE, 
FALSE 

TRUE = coast stop 

FALSE = normal operation 

See parameter 6.2.3. 

STOP_EMCY_COAST BOOL TRUE, 
FALSE 

Emergency coast stop to drive:  

FALSE = stop by coast 

TRUE = no stop 

See parameter 6.2.1. 

STOP_EMCY_RAMP BOOL TRUE, 
FALSE 

Emergency stop to drive 

FALSE = stop by ramp 

TRUE = no stop 

See parameter 6.2.2. 
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Outputs: 
Name Type Value Description 

ACT_SPEED REAL ANY Actual speed (in rpm) read from drive 

See parameter 1.01. 

ACT_SW WORD ANY Main status word read from drive 

See parameter 6.11. 

ACT_VALUE2 REAL ANY Actual torque (in %) read from drive 

See parameter 1.10. 

ALARM BOOL TRUE, 
FALSE 

Drive has an alarm 

See parameter 6.11.7. 

DONE BOOL TRUE, 
FALSE 

Execution finished when output DONE = TRUE. 

ERNO ENUM ANY Internal error code 

ERR BOOL TRUE, 
FALSE 

Error occurred during execution when output ERR = 
TRUE 

EXT_CTRL_LOC_ACT BOOL TRUE, 
FALSE 

Actual external control location EXT2 selected 

See parameter 6.16.11. 

EXT_RUN_ENABLE BOOL TRUE, 
FALSE 

Run enable status 

See parameter 6.18.5. 

LOCAL_CTRL BOOL TRUE, 
FALSE 

Drive control location: LOCAL 

See parameter 6.11.9. 

MESSAGE ENUM ANY State of the function block 

OPERATING BOOL TRUE, 
FALSE 

Drive is operating. 

READY BOOL TRUE, 
FALSE 

Ready to switch on 

See parameter 6.11.0 

TRIPPED BOOL TRUE, 
FALSE 

Drive FAULT 

See parameter 6.11.3. 

USED_CW WORD ANY Application control word 

See parameter 6.02. 

 

Function 

 
The program uses drive parameters as an interface to the drive. 
 
An application control word (06.02) is used to control the drive. It sets the EXT1 
command (20.01) and EXT2 command (20.06) parameters to Application Program. The 
control word is defined in the ABB Drives control profile. 
 
When the drive is in the operational state, the OPERATING output is set to TRUE to 
indicate the current state of the state machine. 
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The program is enabled by setting the EN signal to TRUE. Once active, the block sets the 
configuration parameters to the desired values once: Parameters 19.11, 20.01, 20.06, 
22.11 and 26.11 are set to Application Program. The parameters are intentionally 
changed once enable to change them manually while the program is running. 
 
The drive status is obtained from the Main status word (06.11) and Status word 1 (06.16). 
The actual speed (ACT_SPEED) and torque (ACT_VALUE2) data are obtained from 
parameters Motor speed used (01.01) and Motor torque % (01.10). 
 
When the program is disabled, Application control word is set to 0 once. 
 
If the EXT1 and EXT2 parameters are not set to the correct value while the program is 
enabled, an error is produced. 
 
Error codes and the ERR outputs are internal program errors and not drive fault codes. 
Internal parameter errors do not prevent the program from functioning. 

Limiting 

 
Only one instance of drive control is allowed. This is why it is implemented as a program.  
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Filter 
Summary 

The FILT1_1 function block provides filtering of the high 
frequency part of the input signal. The block acts as a single-
pole low pass filter for the REAL numbers. The balancing 
function permits the output signal to track an external reference. 

Connections 

Inputs: 
Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Balance input, activates the tracking mode. 

BALREF REAL ANY Value for the tracking mode 

IN REAL ANY Input signal for the actual value 

TF REAL 0…ANY Filter time constant (ms) 

TIMELEVEL INT 1…ANY Task interval in milliseconds, default = 10 ms 

Outputs: 
Name Type Value Description 

OUT REAL ANY Filtered actual value 

 

Function 
The function filters the input signal using the current input and previous output. 
The transfer function for a single-pole filter with no passband gain is: 
     Error! Objects cannot be created from editing field codes.   
     (1) 
To get the function for the output, the first step cross-multiplies the equation: 
     Error! Objects cannot be created from editing field codes.  
   (2)  
Resolving the parenthesis gives: 
   Error! Objects cannot be created from editing field codes.  
   (3) 
To get the equation to the time domain s has to be replaced by derivation: 
      Error! Objects cannot be created from editing field codes.  
    (4)  
Since this is a first order approximation function block, the derivation can be replaced by 
a difference: 
    Error! Objects cannot be created from editing field codes.      (5) 
Where: Ts is the cycle time of the program in milliseconds (time difference between 
t and t-1). 

 
The final filtering algorithm (6) is calculated by using the following formula that is obtained 
from (5) by extracting O(t): 
            Error! Objects cannot be created from editing field codes.  
    (6) 
If TF = 0 or negative, the output value is set to the input value. 
Because of the REAL data type limitation, the TF/Ts ration is limited to 8000000, to 
ensure that it is always possible to add 1 to the real value. 
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Function generator 
Summary 

 
The FUNG_1V function block is used for generation of an optional function of one 
variable, y = f(x). The function is described by a number of coordinates. Linear 
interpolation is used for values between these coordinates. An array of 8, 16 or 32 
coordinates can be specified. The balancing function permits the output signal to track an 
external reference and gives a smooth return to the normal operation. 
 
Since the block does not need an internal memory, it also 
comes as a function (CoDeSys for PLC does not support 
multiple outputs for functions). 

Connections 

 
Inputs: 

Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Input for activation of the balancing mode 

BALREF REAL ANY Balance reference 

Input for the reference value in the balancing mode 

IN_XTAB REAL ANY Input signal for the function 

XTAB REAL[N] ANY Table of X coordinates for the function 

YTAB REAL[N] ANY Table of Y coordinates for the function 

 
Outputs: 

Name Type Value Description 

BALREFO REAL ANY TRUE if the high limit is reached. 

ERROR BOOL TRUE, 
FALSE 

TRUE when the input is outside the table range or 
when the table contains unsorted (low to high) data for 
the input coordinates. 

OUT REAL ANY Value of the function 

 

Function 

 
The function generator FUNG_1V calculates output signal Y for a value at input X. 
Calculation is performed in accordance with a piece-by-piece linear function which is 
determined by vectors XTAB and YTAB. For each X value in XTAB, there is a 
corresponding Y value in YTAB. The Y value at the output is calculated by means of 
linear interpolation of the XTAB values, between which lies the value of input X. The 
values in XTAB must increase from low to high in the table. 
 
The output of the block depends only on the current input values, in other words, it does 
not have any state. 
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Interpolation 

 
The generated function is performed as follows: 
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Balancing 

 
If BAL is set to TRUE, the value at Y is set to the value of the BALREF input. The X value 
which corresponds to this Y value is obtained at the BALREFO output. On balancing, the 
X value is calculated by interpolation in the same way the Y value is calculated during the 
normal operation. To permit balancing, the values in YTAB must increase from low to 
high in the table. 

Limiting 

 
If input signal X is outside the range defined by XTAB, the Y value is set to the highest or 
lowest value in YTAB. If BALREF is outside the YTAB value range in the BAL mode, the 
value at Y is set to the value at the BALREF input and BALREFO is set to the highest or 
lowest value in XTAB. 
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Integrator 
Summary 

The INT_REAL function block integrates the input. The 
output signal can be limited within limit values. The 
balancing function permits the output signal to track an 
external reference and gives a smooth return to the 
normal operation. 

 

Connections 

Inputs: 
Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Balance input, activates the tracking mode 

BALREF REAL ANY Value for the tracking mode 

GAIN REAL ANY Gain input 

HOLD BOOL TRUE, 
FALSE 

Stops integration when set to TRUE 

IN REAL ANY Input signal for the actual value 

OHL REAL ANY High input limit 

OLL REAL ANY Low input limit 

RESET BOOL TRUE, 
FALSE 

Clear integrated value 

TI REAL 0…ANY Integration time (ms) 

TIMELEVEL INT 1…ANY Task interval in milliseconds, default = 10 ms 

Outputs: 
Name Type Value Description 

OUT REAL ANY Output value 

OUT_HI BOOL TRUE, 
FALSE 

TRUE if the high limit is reached. 

OUT_LO BOOL TRUE, 
FALSE 

TRUE if the low limit is reached. 
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Function 

 
The INT function can be written in the time plane as:  
 

∫= ))((/)( dttITKtO i  
 

The main controlled property is that the output signal retains its value when the input 
signal I(t) = 0. 

Clearing 

 
The integrated value is cleared when RESET = TRUE (all internal variables are cleared). 

Tracking 

 
If BAL is set to TRUE, the integrator immediately goes into the tracking mode and the 
output value is set to the value of the BALREF input. If the value at BALREF exceeds the 
output signal limits, the output is set to the applicable limit value. On return to the normal 
operation from the tracking mode, integration continues from the tracking reference. 

Limiting 

 
The output value is limited between OHL and OLL. If the actual value exceeds the upper 
limit, the OUT_HI output is set to TRUE. If it falls below the lower limit, the OUT_LO 
output is set to TRUE. If the limits have incorrect values, both OUT_HI and OUT_LO are 
set to TRUE. 
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Lead lag 
Summary 

The LEADLAG_REAL function block is used to filter the input 
signal and provide a phase shifted output. This block acts as 
a lead/lag filter based on the COEF input value. 

 

Connections 

Inputs: 
Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Activates the balance mode 

BALREF REAL ANY Balance reference 

Input for the reference value in the balancing mode. 

COEF REAL ANY Constant that determines the filter type 

IN REAL ANY Input signal for the function block 

RESET BOOL TRUE, 
FALSE 

Resets the function block 

TC REAL 0…ANY Time constant (ms) 

TIMELEVEL INT 1…ANY Task interval in milliseconds, default = 10 ms 

 

Outputs: 
Name Type Value Description 

OUT REAL ANY Output signal 
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Function 

 
The transfer function for the lead/lag filter is:  
 

sT+

s±T+

c

c

1

1

 
 
The lead/lag filter has two input parameters TC and ± (COEF): 

If ± > 1, the filter acts as a lead filter. 
If ± < 1, the filter acts as a lag filter. 
If ± = 1, no filtering is applied. 

The filter algorithm is calculated using the following formula:  

dn = X - B1*dnMem 

Y = A0*dn + A1*dnMem 

dnMem = dn 

Where, 

A0 = (1 + ±*Tc) / (1 + Tc), 

A1 = (1 - ±*Tc) / (1 + Tc), 

B1 = (1 - Tc) / (1 + Tc)  

X is the input signal. 

Y is the output signal.  

The initial value of dnMem is set to zero. 

Note: If the ± or TC inputs to the block are negative, the corresponding negative input is 
assigned to zero before the filter algorithm is calculated. 

Because of the REAL data type limitation, the TC/Ts ration is limited to 8000000, to 
ensure that it is always possible to add 1 to the real value 

Balancing 

 
If BAL is set to TRUE, the value at Y is set to the value of the BALREF input. The block 
operates normally during this time which means that the internal variable is always 
calculated. 

Reset 

 
If RESET is set to TRUE, the internal variable dnMem is set to zero and input value X is 
returned. 
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Motor potentiometer 
Summary 

The MOTPOT_REAL (motor potentiometer) function block is 
used to generate the reference based on the activation of the 
Boolean (UP and DN) inputs. The rate of change of a 
reference signal is controlled by the slope time and limits. The 
current value is retained after a power cycle. 

Connections 

Inputs: 
Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Sets the output to BALREF or limit if it exceeds the 
limit. 

BALREF REAL ANY Sets the output value when he BAL input is active. 

DN BOOL TRUE, 
FALSE 

Enables count down. 

EN BOOL TRUE, 
FALSE 

Enables operations. 

OHL REAL ANY High input limit 

OLL REAL ANY Low input limit 

SLOPE UINT 0..65535 Delay time to count from OLL to OHL and vice versa 

TIMELEVEL INT 1…ANY Task interval in milliseconds, default = 10 ms 

UP BOOL TRUE, 
FALSE 

Enables count up 

Outputs: 
Name Type Value Description 

OUT REAL ANY Output value 

 

Function 

 
The MOTPOT functional block is used to control the rate of change of an output 
reference signal. Digital inputs are normally used as the UP and DOWN inputs. 
 
The rate of change of a reference signal is controlled by the slope time parameter. If the 
enable pin (EN) is set to TRUE, the reference value rises from minimum to maximum 
during the slope time. 
 
EN turns on the MOTPOT function. If EN is set to FALSE, the output is zero. Based on 
the UP or DN inputs getting activated, the output reference increases or decreases to the 
maximum or minimum value based on the slope. If both UP/DN inputs are 
activated / deactivated, the output is neither incremented nor decremented and is in a 
steady state. 
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Clearing 

 
When EN is set to FALSE, the output and internal values are set to zero. 

Tracking 

 
If BAL is set to TRUE, the output is set to the value of the BALREF input. If the value at 
BALREF exceeds the output signal limits, the output is set to the applicable limit value. 

Limiting 

 
The output value is limited between OHL and OLL. If the actual value exceeds the upper 
limit, the output is set to the OHL input value. If it falls below the lower limit, the output is 
set to the OLL input value. 
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PID 
Summary 

The PID_REAL (Proportional-Integral-Derivative) element 
can be used as a generic PID regulator in feedback 
systems. The main extension of the element is that a 
derivative correction term with a filter is included. Another 
major extension is the antiwindup protection. The output 
signal can be limited with limit values specified at special 
inputs (OHL and OLL). The balancing function permits the 
output signal to track a gradual return to the normal 
operation. After any parameter change or error condition, 
the integral term of the correction is readjusted so that the 
output does not change abruptly (“bumpless transfer”). 

Connections 

Inputs: 
Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Balance input, activates the tracking mode. 

BALREF REAL ANY Value for the tracking mode 

GAIN REAL ANY Proportional gain 

IN_FB REAL ANY Actual input value 

IN_REF REAL ANY Reference input value 

I_RST BOOL TRUE, 
FALSE 

Clear integrator 

OHL REAL ANY High input limit 

OLL REAL ANY Low input limit 

TC REAL 0.. ANY Antiwindup correction time (ms) 

TD REAL 0.. ANY Derivation time (ms) 

TF REAL 0.. ANY Filter time (ms) 

TI REAL 0.. ANY Integration time (ms) 

TIMELEVEL INT 1…ANY Task interval in milliseconds, default = 10 ms 

Outputs: 
Name Type Value Description 

DEV REAL ANY Deviation (IN_FB - IN_REF) 

OUT REAL ANY Output signal 

OUT_HI BOOL TRUE, 
FALSE 

TRUE if the high limit is reached. 

OUT_LO BOOL TRUE, 
FALSE 

TRUE if the low limit is reached. 

 



131 

 

 

Function 

 
The differential equation describing the PID controller before saturation/limitation that is 
implemented in this block is: 
 

OUTpresat(t) = Up(t) + Ui(t) + Ud(t) 
 
Where: 
 

OUTpresat is the PID output before saturation 
Up is the proportional term 
Ui is the integral term with saturation correction 
Ud is the derivative term 
t is time.  

 
The proportional term is: 
 

Up(t) = Kp*DEV(t) 
 
Where:  

Kp = P is the proportional gain of the PID controller  
DEV(t) is the control deviation (see below).  
 

The integral correction term is: 
 

0
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Where:  

Kc is the integral antiwindup correction gain of the PID controller  
OUT(t) is the (saturated/limited) output signal of the controller 

 
The antiwindup correction  
 

( ( ) ( ))c presatK OUT t OUT t∗ −   
 

is thus taken to be part of the integral correction term.  
 
Windup is a phenomenon that is caused by the interaction of an error integral action and 
saturations. All actuators have limitations: a motor has limited speed, a valve cannot be 
more than fully opened or fully closed, and so on. For a control system with a wide range 
of operating conditions, it is possible that the control variable reaches the actuator limits. 
When this happens, the feedback loop is broken and the system runs as an open loop 
because the actuator remains at its limit independently of the process output. If a 
controller with the integrating action is used, the error continues to be integrated. This 
means that the integral term may become very large or, in other words, it “winds up”. It is 
then required that the error has the opposite sign for a long period before things return to 
normal. The consequence is that any controller with the integral action may give large 
transients when the actuator saturates. 
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The derivative term is: 
 

( ( ))
( ) *

d DEV t
Ud t Kp Td

dt
= ∗

 
Where:  

Td is the derivative time constant. 
 
The differential equations above are transformed into difference equations by backward 
approximation. 
 
This term is also filtered to make it resistant to high frequency noise. 
 

)*1/(1)( TFssG +=  
 

Smooth transfer 

 
The controller guarantees a smooth transfer in many special situations where, for 
example, control parameters are abruptly changed. This means that in such a bumpless 
cycle the output retains its previous value. This is performed by resetting the integrator 
term Ui to: 
 

( ) ( ) ( ) ( ).Ui t OUT t Up t Ud t= − −  
 
Smooth functionality is not triggered in the first cycle by change in Ti, Tc, Td and Tf. 

Gain, time constants 

 
The proportional gain Kp is directly an input parameter. The integrator, derivative and 
antiwindup gains Ki, Kd and Kc must be calculated from the corresponding time 
constants Ti, Td and Tc which are input parameters. The derivative gain is: 
 

Kd = Td / T 
 
Where:  

T is the time level (execution cycle) of the block (in milliseconds as the time 
constants).  

 
The integral gain is determined from Ti as follows: 
 

Ki = 0, if Ti = 0 
 
Ki = T / Ti, if T < Ti 
 
Ki = 1, if T e Ti > 0 

 
The antiwindup gain is determined similarly by Tc: 
 

Kc = 0, if Tc = 0 
 
Kc = T / Tc, if T < Tc 
 
Kc = 1, if T e Tc > 0 
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Thus the values of Ki and Kc are limited to the range 0 d Ki, Ti d 1. 
 
If Tc = 0, Kc = 0 and antiwindup correction is disabled. 
 
If Ti = 0, Ki = 0. The module does not update the integral term Ui, not even by the 
antiwindup correction. Thus the integrator term retains its original value as long as Ki 
remains zero. 
 
The element stores the “current” set of gains Kp, Ki, Kc and Kd and time constants Ti, Tc 
and Td, which it uses for calculating the control output(s). 

Filtering 

 
This derivative is filtered using a single-pole low pass filter. The following algorithm is 
used to calculate the filtered value: 
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Where:  

T is the time level (execution time) of the block (in milliseconds as the time 
constants).  
 

If the filter time constant is left unassigned, it defaults to 0 which means that the 
derivative is calculated without filtering. The time constant is limited to 8000000*time level 
to avoid underflow. 

Tracking 

 
If BAL is set to TRUE, the regulator goes into the tracking mode and the output follows 
the value at BALREF. If the value at BALREF exceeds the output signal limits (OLL and 
OHL), the output is set to the applicable limit value. The return from the tracking state is 
bumpless. 
 

Limitation function 

 
The limitation function limits the output signal to the value range from OLL to OHL. If the 
presaturated output exceeds OHL, OUT is set to OHL and OUT_HI is set to TRUE. If the 
presaturated output falls below OLL, OUT is set to OLL and OUT_LO is set to TRUE. 
Bumpless return from limitation is requested if and only if the antiwindup correction is not 
in use, that is,. Ki = 0 or Kc = 0. 
 
IF OLL < OHL, both OUT_HI and OUT_LO are set to TRUE and OUT retains the value 
that it had in the execution cycle before the error occurred. After this error, the return to 
the normal operation is smooth 

Limiting 

 
The output value is limited between OHL and OLL. If the actual value exceeds the upper 
limit, OUT_HI is set to TRUE. If it falls below the lower limit, OUT_LO is set to TRUE. 
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Ramp 
Summary 

The RAMP is used to limit the rate of change of a signal. 
The output signal can be limited with limit values 
specified at special inputs. The balancing function permits 
the output signal to track an external reference.  

Connections 

Inputs: 
Name Type Value Description 

BAL BOOL TRUE, 
FALSE 

Balance input, activates the tracking mode. 

BALREF REAL ANY Balance reference 

Input for the reference value in the tracking mode 

IN REAL ANY Input signal for the actual value 

OHL REAL ANY High input limit 

OLL REAL ANY Low input limit 

SLOPE_DN REAL 0.. ANY Negative ramp for the output 

SLOPE_UP REAL 0.. ANY Positive ramp for the output 

STEP_DN REAL 0.. ANY The greatest allowed negative STEP change 

STEP_UP REAL 0.. ANY The greatest allowed positive STEP change 

STOP BOOL TRUE, 
FALSE 

Holds the output (stops ramping) 

TIMELEVEL INT 1…ANY Task interval in milliseconds, default = 10 ms 

Outputs: 
Name Type Value Description 

OUT REAL ANY Output value 

OUT_HI BOOL TRUE, 
FALSE 

TRUE if the high limit is reached 

OUT_LO BOOL TRUE, 
FALSE 

TRUE if the low limit is reached 

 

Function 
The main property of the RAMP element is that the output signal tracks the input signal, 
while the input signal is not changed more than the value specified at the step inputs. If 
the input change is greater than the specified step changes, the output signal is first 
changed by STEP_UP or STEP_DN depending on the direction of change. After that the 
output signal is changed by SLOPE_UP or SLOPE_DN per second, until the values at 
the input and output are equal. This means that if STEP_DN = STEP_UP = 0, a pure 
ramp function, that is, SLOPE/sec is obtained at the output. The greatest step change 
allowed at the output is specified by the STEP_UP and STEP_DN inputs for the 
respective direction of change. 
 
All parameters are specified as absolute values with the same unit as the input. Slopes 
specify the change in units per second. Certain constants are precalculated to make the 
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execution time of the element as short as possible. The results are stored internally in the 
element. These constants are recalculated if the SLOPE_UP or SLOPE_DN values are 
changed. 

Calculation of the output 

 
If Input (t) = Output (t-1), then Output (t) = Input (t) 
 
If Input (t) > Output (t-1), then the change of the output O value is limited as follows: 
 

An internal auxiliary variable VPOS follows the input value with the maximum rate 
of change defined by SLOPE_UP. If the input value is greater than VPOS + 
STEP_UP, the output value is limited to the value VPOS +STEP_UP. If the input 
value is less than VPOS + STEP_UP, the output value is set to be equal to the 
input. 
 
If SLOPE_UP = 0, the output value does not rise no matter what the value of 
STEP_UP and IN is. 

 
If Input (t) < Output (t-1), then the change of the Output value is limited as follows: 

 
An internal auxiliary variable VPOS follows the input value, with the maximum rate 
of change defined by SLOPE_DN. If the input value is less than VPOS –
 STEP_DN, the output value is limited to the value VPOS – STEP_DN. If the input 
value is greater than VPOS – STEP_DN, the output value is set to be equal to the 
input. 
 
If SLOPE_DN = 0, the output value does not lower no matter what the value of 
STEP_DN and IN is. 

Tracking 

 
If BAL is set to TRUE, the ramp immediately goes into the tracking mode and the output 
is set to the value of BALREF. If the value at BALREF exceeds the output signal limits, 
the output is set to the applicable limit value. During the tracking mode VPOS = Output = 
BALREF. The return to the normal operation is done as if a unit step had occurred at the 
input. 

Limiting 

 
The limitation function limits the output signal to the values at the OHL inputs for the 
upper limit and OLL for the lower limit. If the actual value exceeds the upper limit, 
OUT_HI is set to TRUE. If it falls below the lower limit, OUT_LO is set to TRUE. In the 
limiting state VPOS(t) and OUT(t) are set to the applicable limit value. 
 
IF OLL < OHL, both OUT_HI and OUT_LO are set to TRUE and OUT retains the value 
that it had in the execution cycle before the error occurred. 
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Further information 

Product and service inquiries 
Address any inquiries about the product to your local ABB representative, quoting the 
type designation and serial number of the unit in question. A listing of ABB sales, support 
and service contacts can be found by navigating to www.abb.com/drives and selecting 
Sales, Support and Service network. 

Product training 
For information on ABB product training, navigate to www.abb.com/drives and select 
Training courses. 

Providing feedback on ABB Drives manuals 
Your comments on our manuals are welcome. Go to www.abb.com/drives and select 
Document Library – Manuals feedback form (LV AC drives). 

Document library on the Internet 
You can find manuals and other product documents in PDF format on the Internet. Go to 
www.abb.com/drives and select Document Library. You can browse the library or enter 
selection criteria, for example a document code, in the search field. 

 

 

 

 

 

http://www.abb.com/drives
http://www.abb.com/drives
http://www.abb.com/drives
http://www.abb.com/drives
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Contact us 

www.abb.com/drives 

www.abb.com/drivespartners 
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